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Introduction

elcome to Digital Origin MotoDV™, another 
innovative product from Digital Origin 
designed to help you make the most of 

video footage recorded in the DV format. MotoDV allows 
you to transfer DV clips between your computer and your 
DV camcorder or tape deck via an IEEE 1394 serial con-
nection. In addition, it allows you to render effects, titles, 
and transitions applied to these clips in the DV format 
using Adobe Premiere® LE, which is included with 
MotoDV.

MotoDV utilizes the Digital Origin 1394 FireWire host 
adapter card which is also used by PhotoDV™, Digital Ori-
gin’s still image capture plug-in for Adobe® Photo-
shop®and by EditDV, Digital Origin’s DV non-linear editing 
software. The IEEE 1394 connection, also known as 
FireWire (Apple’s trademark) and iLink (Sony’s trade-
mark), is a high-speed serial interface originally devel-
oped by Apple Computer and now adopted by a number of 
companies in the computer and consumer electronics 
industries. The fast transfer rates achievable via 1394 
enable MotoDV to take advantage of the DV circuitry built 
into the DV camcorder or VTR, minimizing the cost and 
complexity of the hardware that must be installed in your 
computer.

MotoDV consists of three primary components:

• The MotoDV capture application transfers DV clips into 
your computer, saving them as QuickTime movies that 
can be imported into QuickTime-compatible applications 
like Adobe Premiere LE. Clips may be captured in either 
real-time or in time-lapse mode. The capture application 

tape deck via the 1394 connection, either with the mouse 
or using keyboard commands.

• The Radius SoftDV™ software codec allows you to play 
back DV clips on your computer screen at a reduced size 
and frame rate so that you can make editing decisions 
while working in Premiere LE. The Radius SoftDV codec 
also allows you to render to the DV format any effects, 
titles, and transitions that you may apply to your video 
clips. Presets for Premiere LE provide the appropriate 
project settings for editing DV clips with the Radius 
SoftDV codec. 

• The MotoDV Player transfers DV clips and movies via 
1394 so that the camcorder or tape deck can play them 
back or record them at full size in full motion. The 
MotoDV Player functions from within Premiere LE and as 
a standalone application. It includes disk control com-
mands that, similar to tape deck control, allow you to 
pause, play, step, and jump forward or backward through 
movies playing back off of a disk drive.

About this manual
The MotoDV User Guide explains how to install and use 
the Digital Origin 1394 FireWire card and the MotoDV 
software.  Chapter 1 discusses the installation and setup 
of your system. Chapter 2 describes how to capture DV 
source material and remotely control the DV camcorder 
or tape deck. Chapter 3 explains how to edit in the DV for-
mat with Premiere LE.  Chapter 4 explains how to output 
your DV clips and movies via 1394 using the MotoDV 
Player, both for playback and recording. 

W

also allows you to remotely control the camcorder or 
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Please note that this user guide assumes that you have a 
working knowledge of your computer and the operating 
system software that comes with it. It also assumes that 
you understand how to properly operate your DV cam-
corder or tape deck. It does not attempt to explain all of 
the features of Adobe Premiere LE. The Premiere LE doc-
umentation is available in electronic format on the 
MotoDV CD-ROM.

NNNNooootttteeee::::    The functionality of MotoDV is nearly identical on 
Windows and Mac OS systems. The screen captures in 
this manual are labeled  “Windows” and “Mac OS” 
mainly for clarity’s sake. Differences between the Mac 
OS and Windows versions are noted when they exist.

System requirements
NNNNooootttteeee:::: Check the Digital Origin web site at www.digitalori-
gin.com for the latest compatibility information and the 
current list of supported DV devices.

To use MotoDV, you need, at a minimum, the following:

For Windows systems
• A 200MHz Pentium-class computer with an available 
PCI expansion slot, 64MB of RAM (128MB is recom-
mended), and 16-bit graphics capability. 

• A graphics card/subsystem with a DirectX/DirectDraw 
compatible driver.

• A CD-ROM or DVD drive.

• Microsoft Windows 95 or 98 or Windows NT4 with Ser-
vice Pack 4. (Service Pack 4 is included on the MotoDV  
CD-ROM.)

• Microsoft DirectX (an update for Windows 95 is on the 

• QuickTime 3.0 for Windows or later (included on the 
MotoDV CD-ROM).

• If you wish to edit your DV clips, an editing application 
like Adobe Premiere LE (included on the MotoDV CD-
ROM). 

• A fast AV hard disk connected to either an internal EIDE 
port or to a SCSI accelerator card with enough hard disk 
space for the projects you wish to complete.

• A Digital Origin 1394 FireWire host adapter card and 
digital interface cable.

• An NTSC or PAL format DV camcorder or tape deck with 
a digital 1394 FireWire port.  This port is frequently 
labeled the “DV” port on many devices. Some devices 
label it the “iLink” port. 

NNNNooootttteeee:::: Some camcorder models only support output via 
1394 and cannot be used to play back or record DV 
streams. These units can only be used for DV input to 
your computer.

For Mac OS systems
• A Power Macintosh or Mac OS compatible computer 
with a PowerPC G3 or 604 processor, an available PCI 
expansion slot, at least 64MB of RAM (128MB is recom-
mended), and 16-bit graphics capability.

• A fast AV hard disk connected to either a fast internal 
SCSI or EIDE port or a SCSI accelerator card with enough 
disk space for the projects you wish to complete.

• Mac OS version 8.1 or later.

• QuickTime 2.5 or later (included with Mac OS). The 
MotoDV CD-ROM includes the QuickTime 3 installer for 
use with applications like Adobe Premiere LE.
MotoDV CD-ROM).
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• A Digital Origin 1394 FireWire host adapter card and 
digital interface cable.

• An NTSC or PAL format DV camcorder or tape deck with 
a digital 1394 FireWire port. This port is frequently 
labeled the “DV” port on many devices. Some devices 
label it the “iLink” port.

NNNNooootttteeee:::: Some camcorder models only support output over 
FireWire and cannot be used to play back or record DV 
streams. These units can only be used for DV input to 
your computer. 

Optional equipment and software
You can further enhance your system with the following 
equipment:

• A video monitor connected to your camcorder’s or tape 
deck’s analog video out port will enable you to see the 
video clips you are capturing, playing back, and record-
ing to tape at full size, in full motion.

• Depending on the length of your projects, you will need 
additional disk space. The DV data rate is approximately 
3.6MB per second which consumes about 216MB of disk 
space per minute or about 13GB per hour. You also need 
to consider that your finished rendered movies take addi-
tional space beyond what your source clips consume.

• Speakers attached to your computer and/or camcorder 
or VTR typically provide better sound than those built 
into the computer. Speakers with dual inputs are recom-
mended because they can be connected to both your com-
puter and your DV device. Headphones can also be useful.

Software updates
Be sure to check the Digital Origin web site 
(www.digitalorigin.com) from time to time for software 
updates to MotoDV. These updates typically provide sup-
port for new DV devices but may also include drivers for 
other operating systems as well as new MotoDV 
features.

Registration
Warranty registration materials are included with 
MotoDV both in hard copy and electronic form. Please 
choose one of these options to register your purchase 
with Digital Origin so that we can provide you with the 
best possible customer support and contact you about 
upgrades and other products designed for DV equipment. 

NNNNooootttteeee:::: Customers outside the United States and Canada 
can also register their purchase with Digital Origin. The 
electronic registration program included with MotoDV 
provides a number of cost-effective options, including 
registration via electronic mail.
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Chapter 1: Installation and Setup

his chapter explains how to install the Digital 
Origin 1394 FireWire host adapter card and the 
MotoDV software in your personal computer. It 

also includes important performance information and 
setup instructions so that you can get the most out of 
your system.

Note that the Digital Origin 1394 FireWire card is essen-
tially a high-speed serial port in and out of your com-
puter and can be used for both still image capture 
(PhotoDV) and for video capture, playback, and recording 
(MotoDV), among other things. The different functions 
that your 1394 card can be used for are determined by 
the software you use, not the hardware components on 
the card itself.

Unpacking
When you first open your MotoDV package, unpack all 
the materials and compare them with the packing list.  If 
you are missing any items, please contact your reseller.

NNNNooootttteeee:::: If you purchased MotoDV as a separate software 
package and have already installed your 1394 FireWire 
card with another Digital Origin DV product, proceed 
directly to the software installation section below.

Installing the 1394 FireWire host 
adapter card
Refer to the documentation included with your personal 
computer for detailed instructions on how to install a PCI 

• Make sure your computer is off before beginning the 
installation. Some manufacturers also instruct you to 
unplug the computer before installing expansion cards.

• Touch the metal casing of your computer’s power sup-
ply before you remove the 1394 FireWire card from its 
antistatic package. This safely discharges any static 
electricity that may have built up on your body.

• Leave the card in its antistatic package until you are 
ready to place it inside the computer.

• Handle the card by the edges only. Do not touch the 
gold-plated PCI connector.

After you have installed the card, double-check to ensure 
that it is firmly and completely seated in the PCI slot. 
Replace the retaining screw in the expansion slot bracket 
so that you do not accidentally unseat the card when you 
plug in the cable.

Connecting the cable
A digital interface cable is included with MotoDV. The 
larger end (6-pin connector) plugs into one of the connec-
tors on the back of the 1394 FireWire card. The smaller 
end (4-pin connector) plugs  into the digital 1394 port on 
your camcorder. This port is usually labeled the “DV” 
port. (On some devices, this may be designated as the 
“iLink” port.)

T

card in one of its expansion slots.  Before proceeding:
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To connect your camcorder to the Radius 1394 

FireWire host adapter card,

1  Plug the larger end of the cable into one of the connec-
tors on the card as shown. You can use any one of the 
three connectors.

Connecting the cable to the Digital Origin 1394 FireWire card

NNNNooootttteeee::::    The version of the 1394 FireWire driver software 
supplied with MotoDV currently only supports one 
connected device.

2  Plug the smaller end of the cable into the DV port on 
your DV device as shown. Note that the location of the DV 
port varies, depending on what kind of camcorder or tape 
deck you own.

NNNNooootttteeee::::    If you are going to transfer clips to and from your 
camcorder for an extended period of time, you should 
also connect the camcorder to an external power source 
using the AC power cord that is supplied with it.

You may also wish to connect a video monitor to the cam-
corder or tape deck’s analog video out ports. Use a com-
posite or S-video cable (not supplied with MotoDV), 
depending on the type of connections supplied by your 
camcorder or tape deck and video monitor.

Installing the MotoDV software on 
Windows computers
The software needed to run MotoDV is installed from the 
CD-ROM included with the product. 

NNNNooootttteeee::::    If you are upgrading from a previous version of 
MotoDV with the “Radius” label (Digital Origin’s former 
name), and wish to uninstall this software from your 
hard disk, it is eeeexxxxttttrrrreeeemmmmeeeellllyyyy    iiiimmmmppppoooorrrrttttaaaannnntttt that you do so 
BBBBEEEEFFFFOOOORRRREEEE you install the new Digital Origin version of 
MotoDV.

If you run the uninstaller program in the Radius folder 
after you install the newer Digital Origin software, you 
may remove system files required by MotoDV. If this 
happens, reinstall the Digital Origin MotoDV software as 
described below. 

If you are running Windows 95 or 98, you will first install 
the driver for the 1394 FireWire card, before you install 
the rest of the MotoDV software. (The driver for 
Windows NT4 is installed when you install the MotoDV 
software.)
Connecting the cable to a DV camcorder
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You should then install Adobe Premiere LE so that the 
MotoDV installer can place the MotoDV Player plug-in 
and presets directly into the appropriate folders.

After you install Premiere LE and the MotoDV software, 
you will install supporting software such as QuickTime 
for Windows and DirectX, if the appropriate versions are 
not already present in your system. If you are running 
Windows NT4, you may also need to install Service 
Pack 4.

These steps are described in more detail in the following 
sections.

Installing the 1394 driver
If you are running Windows 95 or 98, the operating sys-
tem will prompt you to install driver software after you 
add new hardware to your system. The driver installa-
tion procedures differ slightly for Windows 98, Windows 
95 OSR2, and Windows 95 August Release. Each installa-
tion is described in this section.

NNNNooootttteeee::::    There is no separate driver installation procedure 
for Windows NT4. The NT 1394 driver is installed when 
you install the MotoDV software, as described below.

To install the driver for the 1394 host adapter card 

for  Windows 98,

1  Startup your computer. The New Hardware Found 
window should appear briefly, followed by the Add New 
Hardware Wizard. Click Next.

2  Check the “Search for the best driver for your device” 
button and click Next.

3  If you have not done so already, insert the MotoDV CD-
ROM into your computer and wait a few seconds for it to 
come up to speed before proceeding.

4  Check the CD-ROM drive box and uncheck all other 
options in the window. Click Next.

Add New Hardware Wizard (Windows 98)

NNNNooootttteeee:::: Do NOT use any of the 1394 drivers that are 
included on the Windows 98 CD-ROM. You must use the  
1394 driver included on the MotoDV CD-ROM.

5  When the Add New Hardware Wizard asks you which 
driver you want to install, check the button next to the  
1394 Host Adapter and click Next.

Selecting the 1394 driver (Windows 98)
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6  The Add New Hardware Wizard will tell you it is ready 
to install the best driver for the device. The letter that 
represents your CD-ROM drive should appear as the 
“Location of driver”. Click Next.

The 1394 driver selected (Windows 98).

7  Click Finish. You mmmmuuuusssstttt then restart your computer for 
the driver to load properly. 

To install the driver for the 1394 host adapter card 

for  Windows 95 OSR2,

1  Startup your computer. The New Hardware Found 
window should appear briefly, followed by the Update 
Device Driver Wizard.

2  Insert the MotoDV CD-ROM into your computer, wait a 
few seconds for the CD to spin up to speed, and click Next. 

3  The Wizard should tell you that it found the driver for 
the 1394 Host Adapter. If it does not find the driver, click 
Back and then Next again, in case the CD was not ready 
the first time. Click Finish.

Update Device Driver Wizard (Windows 95 OSR2)

NNNNooootttteeee:::: Depending on how your computer was configured 
by its manufacturer, the Wizard may complete the driver 
installation at this point. If so, restart your computer. If 
not, complete the remaining steps.

4  Click OK if the Insert Disk message appears asking for 
the MotoDV CD-ROM again.

5  When the Copying Files... window appears, click 
Browse. 

Copying Files... window (Windows 95 OSR2)

6  The Open window appears. Select the letter that rep-
resents your CD-ROM drive from the drop-down list in 
the Drive(s) section of this window. The file “pcilynx.inf” 
should appear in the left side of the window. Click OK. 
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The Open window (Windows 95 OSR2)

7  The letter that represents your CD-ROM drive should 
now appear in the “Copy files from:” section at the bot-
tom of the Copying Files... window. Click OK.

8  You mmmmuuuusssstttt then restart your computer for the driver to 
load properly. 

To install the driver for the 1394 host adapter card 

for Windows 95 August Release (also known as Win-

dows 95a),

1  Startup your computer. The New Hardware Found 
window should appear.

2  Select the button “Driver from disk provided by hard-
ware manufacturer”, then click OK.

New Hardware Found window (Windows 95a)

3  When the Install From Disk window appears, insert 
the MotoDV CD-ROM into your computer and wait a few 
seconds for it to come up to speed. Then click the Browse 
button.

4  Select the letter that represents your CD-ROM drive 
from the drop-down list in the Drive(s) section of the 
Open window. The file named “pcilynx.inf” should 
appear in the left side of the window. Click OK.

The Open window (Windows 95a)

5  The letter that represents your CD-ROM drive should 
now appear in the “Copy manufacturer’s files from:” 
section at the bottom of the Install From Disk window.  
Click OK.

Install From Disk window (Windows 95a)

6  You mmmmuuuusssstttt then restart your computer for the driver to 
load properly.
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To verify that the driver is properly installed,

1  Choose Settings and then Control Panel from the Start 
menu.

2  Double-click on the System icon and then click on the 
Device Manager tab. You should see an entry titled “1394 
Bus Controller” (Windows 98) or “Digital Origin 1394 
Devices” (Windows 95a and OSR2).

3  Click on this entry and verify that there are no con-
flicts (indicated by either a red “x” or a yellow “!”.)

Device Manager for Windows 95 and for Windows 98

If you have a conflict, use the Windows help system to 
try to resolve it. From the Start menu choose Help and 
display the “Troubleshooting hardware conflicts” topic, 
following the step-by-step procedures presented by this 
help wizard.

NNNNooootttteeee:::: If you are upgrading from a previous version of 
MotoDV with the “Radius” label, then the Device 
Manager entry for the driver may continue to be listed as 
“Radius 1394 Devices” under Windows 95. For 
Windows 98, the entry under “1394 Bus Controller” may 
remain as “Radius 1394 Host Adapter”. This will not 
affect the operation of MotoDV.

Device Manager entries with Radius-labeled driver

To install the driver for the 1394 host adapter card 
for  Windows NT4,

Install the MotoDV software as described below. The    
Windows NT4 driver for the 1394 card will be installed at 
that time. There is no separate driver installation proce-
dure for NT4.

Installing Premiere LE, MotoDV, and 
other supporting software
After you have installed the driver and restarted your 
computer, you will need to install the other software 
components on the MotoDV CD-ROM, starting with Adobe 
Premiere LE.

1  Reinsert the MotoDV CD-ROM if you removed it after 
installing the driver. If the installation window does not 
automatically appear on your screen, double-click on the 
icon that represents your CD-ROM drive in the My Com-
puter window.

2  Click the Read Me button for additional information 
about using MotoDV.
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3  Click on the Install Premiere LE button to install this 
program. Locate the Premiere LE installer program on 
the MotoDV CD-ROM and follow its instructions.

4  Click on the Install MotoDV button to install the 
MotoDV software and its system files. The installer will 
also locate the Plug-ins and Settings folders for Premiere 
LE and place the appropriate files there. 

5  Click the Install QuickTime button and follow the 
instructions to install QuickTime for Windows on your 
system.

6  If you are running Windows 95, then the MotoDV 
installer window will include an option to install a newer 
version of Microsoft DirectX. Click the Install DirectX but-
ton and follow the instructions. The DirectX installer will 
determine if DirectX needs to be updated. When 
prompted, restart your computer.

If you are running Windows NT4, you need to install 
Microsoft’s Service Pack 4. Click the Install Service Pack 
4 button and follow the instructions. If you have suffi-
cient disk space, be sure to select the option that allows 
you to uninstall Service Pack 4, in case you need to trou-
bleshoot your system.

Verifying the NT driver installation
If you are running Windows NT4, the driver for the  1394 
FireWire card is installed when you install the MotoDV 
software.

To verify that the NT driver is properly installed,

1  Make sure you have restarted your computer after 
installing the MotoDV software.

2  Choose Settings and then Control Panel from the Start 
menu.

3  Double-click on Services to open the Services window.

4  If necessary, scroll down until you locate the Radius 
1394 Bus Manager entry. It should  be set to automatic 
and indicate that the service has started.

NNNNooootttteeee:::: The 1394 driver for Windows NT will be shown as 
“Radius 1394 Bus Manager” for both new installations 
and for systems being upgraded from previous versions. 
There is no Digital Origin-labeled 1394 driver for        
Windows NT at this time. This difference is strictly     cos-
metic and will not affect operation.

The Radius 1394 Bus Manager entry in the NT Services window

5  If the status indicates that it has not started, highlight 
the Radius 1394 Bus Manager entry and click the Start 
button in the Services window.

Starting your Windows system
Now that you have installed all the necessary compo-
nents of your system, you are ready to get started. Use 
the following routine to ensure a consistent and reliable 
connection between your computer and DV device:

1  Turn off your computer and your DV camcorder or 
tape deck. Wait several seconds.

2  Turn on your computer.
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3  When your computer has completed the startup pro-
cess, turn on your DV camcorder or tape deck. Insert one 
of your source tapes into the device.

Before proceeding to chapter 2 for an explanation of how 
to capture your clips with MotoDV, read the important 
setup information at the end of this chapter.

Installing the MotoDV software on 
Mac OS computers
The MotoDV software for Mac OS consists of several files 
as well as system extensions. The MotoDV installer lets 
you specify the location to install these files. It automati-
cally installs the system extensions in the System Folder 
of your startup disk.

Before installing the MotoDV software, you may need to 
install other software.

Mac OS 8.1 or later
While the MotoDV software should function properly 
with Mac OS version 7.6.1, Digital Origin recommends 
that you use Mac OS version 8.1 or later. If you do not 
have Mac OS 8.1 or later installed, you will need to pur-
chase an upgrade from your Apple dealer or contact 
Apple for a system update. 

NNNNooootttteeee::::    Select About This Macintosh... from the Apple menu 
to determine the version number of the system software 
you are running. 

QuickTime 2.5 or later
QuickTime 2.5 or later is required by MotoDV and must 
also be installed in your system. In general, QuickTime 
2.5 or later is installed with Mac OS 8.0 and 8.1. 

NNNNooootttteeee::::    To determine which version of QuickTime is 
installed, highlight the main QuickTime file icon in your 
Extensions folder and select Get Info from the File menu.

MotoDV is compatible with QuickTime 3 and the installer 
for QuickTime 3 is included on the MotoDV CD-ROM for 
your convenience. Adobe recommends installing 
QuickTime 3 when using Adobe Premiere LE. 

Note, however, that you will need an upgrade to the Pro 
Edition of QuickTime 3 in order to use many of the fea-
tures in MoviePlayer 3 that were included in Mov-
iePlayer 2.5. The QuickTime 3 Pro upgrade is available 
from Apple for a small fee.  See Appendix B for more 
information on using MoviePlayer for basic editing oper-
ations.

When you have determined you have the correct system 
software installed, you are ready to install the MotoDV 
software.

To install the MotoDV software in a Mac OS system:

1  Insert the MotoDV CD-ROM into your computer.

2  Locate the installer for Adobe Premiere LE on the CD-
ROM and double-click on it to start the installation. Fol-
low the instructions until Premiere LE is installed.

3  Double-click on the MotoDV installer. Click continue 
and read the information in the read me file. Click con-
tinue again.
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4  Specify where you want to install the MotoDV files 
that are not system extensions using the pop-up menu in 
the installer’s window.

The MotoDV Installer window

You can choose either a hard disk or select a folder. To 
select a folder, use the navigation dialog box that appears 
when you choose “Select Folder” in the pop-up menu.

Specifying a folder for the MotoDV files

The installer will place the MotoDV files on the hard 
drive or in the folder you selected and the MotoDV system 
extensions in the Extensions folder of the active System 
Folder.

NNNNooootttteeee::::    To install the MotoDV system extensions on a disk 
drive other than your current startup disk, you will need 
to restart your system with the new drive designated as 
the startup disk using the Startup Disk control panel. 
Make sure that the Mac OS is installed on this drive.

5  Click install.

6  When complete, click restart to restart your computer. 

NNNNooootttteeee::::    The MotoDV installer will place an electronic regis-
tration program in the Startup Items folder of your Sys-
tem Folder. When you restart your computer, this 
application will launch and ask you to register your copy 
of MotoDV. Once you complete this process, the registra-
tion program is automatically moved to the trash folder. 
The serial number for your MotoDV software is located 
on the back of the MotoDV user guide. You will need this 
number to complete the MotoDV registration.

7  After your computer has restarted, copy the MotoDV 
presets and print to video plug-in to their appropriate 
folders. 

• Copy the MotoDV presets to the Premiere LE Settings 
folder.

• Copy the Print to MotoDV plug-in to the Premiere LE 
Plug-ins folder.

Before proceeding to chapter 2 for an explanation of how 
to capture your clips with MotoDV, read the important 
setup information in the next section.
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Important setup information 
The following information will help you optimize the con-
figuration of your system so that you can be more pro-
ductive when editing your DV footage.

General setup information
It is important to note that when MotoDV outputs DV data 
streams via the 1394 connection (as opposed to playing 
back clips on your computer screen), the video will be 
decoded by the DV camcorder or tape deck.  In order to 
see your video, you will need to connect a video monitor 
to the camcorder or tape deck. (If you are using a cam-
corder, you could look in the camcorder’s viewfinder or 
use its LCD screen instead but this isn’t always practical.)

Likewise, to hear the audio from a DV stream output via 
1394, you will need to connect speakers or headphones to 
your camcorder or tape deck. 

Make sure the hard disk you use for your video and audio 
clips is not fragmented. You can purchase disk optimizing 
software from a number of companies to keep your files 
from becoming fragmented. Alternately, after you 
backup any necessary data, you can reinitialize the 
drives you use for your media files. Be careful! The reini-
tializing process removes all existing files from the disk.

Windows performance issues
MotoDV’s excellent capture and playback performance 
allow you to use most standard Ultra DMA disk drives as 
media drives in your system. Note, however, that you 
may need to enable DMA to the drive(s) to prevent 
dropped frames or late interrupts during capture and 
playback. The procedure for doing this is different for 
Windows 95/98 than from Windows NT4.

under Windows 95 or 98,

1   Choose Settings and then Control Panel from the Start 
menu.

2  Double-click on the System icon and then click on the 
Device Manager tab. You should see an entry titled “Disk 
drives”. Click on it once.

3  Highlight the IDE entry that represents your hard disk 
drive and click the Properties button.

4  Select the Settings tab, check the DMA box and apply 
your changes, following the onscreen instructions.
To enable DMA to an Ultra DMA IDE drive running To enable DMA to an Ultra DMA IDE drive running 
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under Windows NT4,

1  Make sure you have installed Service Pack 4 from the 
MotoDV CD-ROM, as described above.

2  Download the file “Dmachcki.exe” from the Microsoft 
ftp site at: ftp://ftp.microsoft.com/Softlib/MSLFILES/

3  Once downloaded, double-click the file to expand the 
archive. Then launch the Dmacheck.exe program.

4  Click the “Enabled” button for each IDE channel to 
which you have Ultra DMA disk drives attached and fol-
low the onscreen instructions.

Mac OS performance issues
The following information will help you get the best per-
formance possible out of your Mac OS system and config-
ure it for optimal use. Please take the time to follow the 
instructions below.

• Turn off virtual memory in the Memory control panel.

• Also in the Memory control panel, set the disk cache to 
the lowest possible setting, typically 96K or 128K. After 
you make the appropriate settings, as shown here, 
restart your computer.

itor is set to either Thousands (16-bit mode) or Millions 
(24-bit mode) of colors.

• The standard external SCSI port found on most Mac OS 
computer models is “slow” SCSI and is not suitable for 
capturing and playing back DV streams via 1394, in spite 
of the fact that this port has a theoretical transfer rate of 
5MB per second. You must connect your media drives to 
either the appropriate internal port or to a SCSI card, as 
described immediately below.

• If you are using a Power Macintosh G3 model, then you 
should be able to successfully use internal Apple ATA 
drives connected to the internal EIDE port or fast (e.g. at 
least 7200 rpm) SCSI drives connected to a SCSI accelera-
tor card. Note that, unlike the preceding 604-based 
machines, the internal motherboard SCSI port in most G3 
models is “slow” SCSI and is not suitable for capturing 
and playing back DV streams over FireWire.

• If you are using a Power Macintosh computer that orig-
inally shipped with a PowerPC 604 processor, then you 
will get the best 1394 playback performance if you con-
nect a fast (e.g. at least 7200 rpm) “narrow” (the connec-
tor type) SCSI drive to the fast motherboard SCSI port 
found on most 604 models. Check with your computer 
manufacturer if you are unsure if your 604 model has 
fast motherboard SCSI.

• If you need to use a SCSI controller card on a 604-based 
machine, then you may need to slow down the rate at 
which it sends and receives data to and from the attached 
drives in order to prevent it from using excessive band-
width on the PCI bus. SCSI cards using excessive PCI 
bandwidth can prevent the 1394 FireWire card from suc-
cessfully playing DV streams over FireWire (resulting in 
a DMA error) or cause the video to break up with a series 
of random gray blocks.
• Use the Monitors control panel to make sure your mon- NNNNooootttteeee:::: Limiting a SCSI card’s transfer rate is only poten-
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tially necessary for PCI Mac OS computers that originally 
shipped with 604 or 603 processors. Apple’s Power 
Macintosh G3 models offer superior PCI bus performance, 
allowing a SCSI card to operate at full speed without 
affecting 1394 output.

You limit a SCSI card’s transfer rate with its control soft-
ware (e.g. Adaptec’s PowerDomain utility for the Adaptec 
2940UW card). Depending on the speed of your attached 
drives, you may need to use the control software to dis-
able Ultra SCSI and wide transfers, and possibly to limit 
the transfer rate. Because the DV data rate is modest 
(3.6MB per second) you generally will not notice any side 
effects as a result of changes to these settings. Contact 
your SCSI card manufacturer if you need assistance lim-
iting its transfer rate.

Alternately, if your computer has more than three slots 
(and therefore two banks of PCI slots), you can try put-
ting the SCSI card in one PCI bank and the 1394 FireWire 
card in the other.  The exceptions to this are the UMAX 
S900 and J700; these models seem to function best with 
the SCSI and FireWire cards together in the two top slots 
(S900) or two middle slots (J700).

• Use the Sound control panel (also included in the Moni-
tors and Sound control panel) to set your computer’s 
sound input source (e.g. from the internal CD) and its 
sound output port, if any. While these particular settings 
do not directly affect MotoDV’s operation for the most 
part, you may need to be familiar with them to edit your 
video projects. 

• MotoDV’s performance is not generally impacted as 
much as some video products by certain Mac OS system 
features such as the menu bar clock and AppleTalk net-
work connections, especially on Power Macintosh G3 
machines. However, if you need to allocate the maximum 

try minimizing the number of things that eat up your 
computer’s processor cycles. If you are not satisfied with 
your system’s performance, try the following:

1  Use Apple’s Extensions Manager control panel to limit 
the number of system extensions and control panels that 
load when your computer starts up. Be careful not to dis-
able those extensions required by your video editing sys-
tem.

NNNNooootttteeee::::    Use of extension management utilities other than 
Apple’s Extensions Manager is not recommended. These 
software packages can actually prevent critical MotoDV 
system extensions from loading, causing problems with 
MotoDV’s operation.

2  If you do not require network access while doing your 
video work, disable AppleTalk from the Chooser or the 
Control Strip. Some editing applications, such as Adobe 
Premiere, prefer that AppleTalk be disabled when run-
ning.

3  Disable the menu bar clock using the Date & Time con-
trol panel.
possible system resources to your video editing efforts, 
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Chapter 2: Capturing DV

his chapter explains how to capture and save DV 
clips from a DV camcorder or tape deck, either 
in real-time or in time-lapse mode, as well as 

how to remotely control these devices from your com-
puter. Clips captured with MotoDV are saved as Quick-
Time movies with separate video and audio tracks and 
can be used with Adobe Premiere LE and other Quick-
Time-compatible applications. This chapter also explains 
how to optimize software playback of your clips on your 
computer screen in applications like Apple’s MoviePlayer.

Because the DV data stream is already digital, MotoDV 
transfers the DV clips onto your computer’s hard disk 
without generation loss. There is no analog-to-digital 
conversion when clips are captured.

Before you capture
Make sure your DV device is on and connected to the 
Radius 1394 FireWire card. If you are using a camcorder, 
set it to VTR mode. Then launch the MotoDV capture 
application, located in the MotoDV folder. 

NNNNooootttteeee:::: (Windows only) The standalone MotoDV capture 
application cannot be running at the same time as the 
MotoDV Player or Adobe Premiere LE when the MotoDV 
Playback plug-in is installed in its plug-ins folder.

Choose NTSC or PAL as your default video format, 
depending on the DV equipment you are using.

The MotoDV capture window (Windows)

The MotoDV capture window (Mac OS)

Before capturing any material, however, you need to 
choose a capture mode, select a drive or folder to capture 
to, and set your capture preferences. 

T
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Select a capture mode
You set the capture mode by selecting Capture Options... 
from MotoDV’s Windows menu and choosing an option 
from the pop-up menu. 

Capture Options (Windows) Capture Options (Mac OS)

Changes you make to this setting remain in effect until 
you change them again. Two modes are available:

• Real time This mode captures all of the audio and 
video information coming via 1394 in “real time”; for 
example, ten seconds of footage takes ten seconds to cap-
ture. This is the default capture mode when you first 
launch MotoDV.

• Time lapse This mode captures only the video 
frames you specify to create a time lapse effect. Note 
that no audio track is captured in time lapse mode.

To set the parameters for time lapse capture,

• Capture Choose frames, seconds, or minutes from the 
first pop-up menu in the time lapse section and enter the 
number you want to capture.

• Every Set the interval between captures by entering a 
number and setting the pop-up menu.

• Until Set the movie length by entering a number and 
setting the pop-up menu. If you choose Stop from the pop-
up menu, MotoDV will capture in time lapse mode until 

Time lapse capture (Windows) Time lapse capture (Mac OS)

Once you have set these parameters, MotoDV calculates 
the total capture time, the movie length, and the disk 
space required to capture the movie.

Note that when you are capturing in time lapse mode, 
MotoDV’s preview window only displays the frames that 
are being recorded to disk.

Select a capture location
You set the disk or folder you wish to capture your DV 
clips to by clicking on the path button (not labeled in the 
Windows version) in the Capture location section of the 
MotoDV window. The current file directory path is dis-
played.  If you wish, create a new folder for the clips you 
are about to capture. Be sure to select a disk drive that is 
fast enough to capture at the DV data rate.

Capture location  (Windows) Capture location (Mac OS)
you manually stop it.
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MotoDV displays the amount of disk space remaining on 
the disk you selected and translates this disk space into 
the amount of time remaining for capturing clips at the 
DV data rate.

MotoDV also calculates “Disk Performance”, which is the 
rate at which it was able to write the last clip to your 
hard disk. This information is important because it lets 
you know if the performance of your disk drive is chang-
ing, either because of file fragmentation or because clips 
are being captured to the slower inner sectors of the 
drive.

NNNNooootttteeee::::    Because of the way MotoDV buffers captured video 
in memory, you may be able to successfully capture clips 
even if MotoDV reports disk performance lower than the 
DV data rate of 3.6MB per second. In general, however, 
you should be using a disk drive that can sustain at least 
this data rate, preferably faster.

Set your capture preferences
To set your capture preferences for MotoDV, select Pref-
erences... from MotoDV’s Edit menu.

Capture prefs (Windows) Capture prefs (Mac OS)

The top section of the preferences window provide three 
tests to help ensure the integrity of the clips you capture 

from DV tape. Each test provides three options: do noth-
ing, show warning (after the capture is completed), and 
abort capture.

• When detecting... discontinuous timecode 
The most common reason for discontinuous timecode on 
a DV tape is a gap between clips that occurs when you 
are shooting and reviewing your footage. If you are not 
careful, it is easy to advance a few seconds past the end 
of your last clip. When this happens, the camcorder usu-
ally resets the timecode of the next clip to zero.

For this reason, the default setting for this test is “show 
warning” because encountering a discontinuity in the 
timecode does not necessarily mean that MotoDV dropped 
frames during capture. However, if you are certain that 
the footage you are capturing has continuous timecode, 
this test can provide additional assurance that you are 
capturing all of the frames in your video.

• When detecting... dropped frames  As its name 
suggests, this test is the primary means for checking for 
dropped frames. The 1394 FireWire driver software 
sends a message to the MotoDV capture application when 
it detects a dropped frame. In general, most video editors 
leave this test set to “abort capture” because they cannot 
tolerate even a single dropped frame. If you find that 
MotoDV repeatedly drops frames, make sure that the 
disk to which you are capturing can sustain the neces-
sary transfer rate to record your DV clips. In addition, 
review the setup information in chapter 1, the “Compen-
sating for slower disks” section below, and the trouble-
shooting section of this manual.

• When detecting... audio sample rate change 
MotoDV cannot capture the audio portion of a DV clip cor-
rectly if it encounters a change in the audio sample rate 
as it is recording the DV stream to your hard disk. This 

test informs you that a change in the audio sample rate 
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has been detected. The default setting is “abort capture” 
because the audio portion of the clip will be distorted 
after the sample rate change occurs. 

The built-in microphones in many DV camcorders only 
record a single audio sample rate (typically 32kHz). 
Users with camcorders that can record different sample 
rates typically pick one rate and leave it at that setting. 
As a result, changes in the audio sample rate on your 
source tapes may be very rare. They are more likely to 
occur if you record different finished projects, each with 
different sample rates, to the same tape. 

For example, you may record a music video at 44.1kHz 
(the CD sample rate) and then an interview at 32kHz. If 
you then recapture both of these segments with MotoDV 
as a single clip, you will encounter a change in the audio 
sample rate. The audio in the second segment will be dis-
torted, if you continue capturing. You must recapture the 
segments individually to prevent this distortion.

• Enable audio playthrough  (Mac OS only) If you 
check this option, MotoDV will decode the audio stream 
as you preview and capture your DV clips. The audio is 
played back through the computer’s speakers, in sync 
with MotoDV’s preview window.

Depending on the speed of your computer, you may wish 
to leave this option unchecked so that you can dedicate 
maximum processing power to capturing your clips. Con-
necting speakers or headphones to your camcorder or 
VTR will allow you to monitor the audio on your tapes 
without using additional processing power.

NNNNooootttteeee:::: If you are using a video monitor attached to your 
camcorder or tape deck to view the material you are cap-
turing, the audio you hear playing through the com-
puter’s speakers may be slightly behind the video it 

to decode the DV data stream in the preview window. It 
does not affect the synchronization between the audio 
and video in the clips you capture to your hard disk. If 
you find this delay distracting or objectionable, connect 
speakers to your DV device to monitor the audio as you 
capture clips. 

• 16:9 (Widescreen)  Checking this box displays the 
video in MotoDV’s preview window in an aspect ratio of 
16:9 and tags captured footage as 16:9 source clips. Use 
this setting if you recorded in 16:9 mode.

• NTSC or PAL  Use these buttons to switch between 
the NTSC and PAL video formats, depending on the kind of 
DV equipment you are using. 

Preview window settings
MotoDV’s preview window allows you to view the con-
tents of your tapes without connecting a separate video 
monitor to your camcorder or VTR.

NNNNooootttteeee:::: Your display must be set to 16-bit, 24-bit, or 32-bit 
color to see video in MotoDV’s preview window. 

You can adjust the quality of the image displayed in the 
preview window, trading off quality for speed.

MotoDV preview window

The preview quality slider offers three settings. The set-
ting to the right provides the sharpest picture but 
requires more processing power. Depending on the speed 
displays. This is caused by the processing time required of your computer, the video may not play smoothly in the 
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preview window. If this is the case, try one of the other 
two settings. These play faster but at a lower quality 
level. 

Preview quality slider (Windows)

Preview quality slider (Mac OS)

Note that when the camcorder or tape deck is paused, the 
preview window always uses the sharper quality level 
for display. When you are capturing, it always uses the 
fastest setting in order to minimize the amount of pro-
cessing power needed to decode the video for preview 
and maximize the amount available for capture. Regard-
less of which setting you choose, you are always captur-
ing the full quality DV data stream.

Capturing DV clips from tape
You are now ready to transfer DV clips from your tapes 
to your hard disk. To make this process easier, MotoDV 
allows you to remotely control your camcorder or tape 
deck from the computer so that you don’t need to use the 
buttons on the device itself. The remote control com-
mands are described in more detail below.

NNNNooootttteeee::::    The maximum file size you can capture on either a 
Mac OS or Windows system is 2GB, a little less than ten 
minutes of DV footage.

To capture a clip to your hard disk,

1  Make sure the digital interface cable is plugged into 
both the computer and the digital 1394 port of your cam-
corder or tape deck.

Active keypad (in VTR mode)

2  If you are using a camcorder, set it to VTR mode. 
MotoDV’s remote control keypad should be visible. If you 
will be capturing clips for an extended period of time, you 
may also wish to power your camcorder with its AC 
power adapter.

3  Insert the appropriate tape cassette into the cam-
corder or tape deck.

4  Click the keypad’s play button or press the space bar 
or the up arrow key to start the tape playing. The foot-
age on your tape should be visible in the Preview win-
dow.

5  Click the Capture button or press enter or return on 
your keyboard when you want to start capturing.

6  When you want to stop capturing and save the clip, 
click the Stop Capture button or press enter or return on 
your keyboard. Typing escape (Windows) or command-
period (Mac OS) also stops your capture. The camcorder 
or VTR will pause.

NNNNooootttteeee:::: Be sure to capture a few additional seconds of 
material at each end of a clip. These “handles” will 
ensure that you have sufficient media to do transitions 
and effects between clips in your projects.
7  Type in a name for your clip and click the Save button 
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or press the enter or return key.

MotoDV file name window (Windows)

MotoDV file name window (Mac OS)

Automatic naming
MotoDV provides an automatic naming scheme to help 
you capture your clips faster and keep them organized.

When you stop capturing a particular clip, you are 
prompted to enter a name for it. When you capture 
another clip, MotoDV remembers the last name you 
entered and sequentially appends a number to this base 
file name. For example, if you name the first clip you cap-
ture “Vacation”, the next clip will automatically be named 
“Vacation-2”, unless you type in a new name. 

You may want to continue a naming scheme already 
established in a previous capture session. For example, if 
you have captured 20 clips from your recent trip to Paris 
and have named them “Paris-1”, “Paris-2”, “Paris-3”, 
through “Paris-20”, you can continue this scheme by 
naming the first clip of the new session “Paris-21”. 
MotoDV will automatically name the next clip “Paris-22” 
and continue with this sequential numbering until you 
enter a new base file name.

Remote deck control
As mentioned previously, MotoDV allows you to remotely 
control your camcorder or tape deck from the computer. 
This “remote deck control” makes it much easier to 
locate the starting “in” points for your captures. 

The MotoDV keypad buttons function much like the but-
tons on your camcorder or tape deck. Each is explained 
briefly here, along with their keyboard equivalents.

NNNNooootttteeee:::: MotoDV’s remote deck control may not support all 
of the capabilities of your particular device.

• Pause/Play When pressed, the pause/play button 
starts playing the tape in the camcorder or tape deck. 
Pressing the button again pauses the tape. The pause/
play button will also pause the tape if it is pressed when 
the camcorder or tape deck is in slow play, search, fast 
forward or rewind mode.

Pause/Play

You can also use the ssssppppaaaacccceeee    bbbbaaaarrrr or the uuuupppp    aaaarrrrrrrroooowwww key to 
toggle between pausing and playing the tape.

• Stop The stop button not only stops the camcorder or 
tape deck playing, it also retracts the tape from the tape 
heads. Use this button if you are done capturing clips 
from a tape or if you want to rewind or fast forward at 
the fastest speed. Otherwise, use the pause button to stop 
the tape. From the keyboard, use the ddddoooowwwwnnnn    aaaarrrrrrrroooowwww key to 
stop the camcorder or tape deck.
Stop button
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• Rewind and Fast Forward If the camcorder or 
tape deck is stopped, clicking the rewind or fast forward 
button rewinds or fast forwards the tape at about 20x 
speed. The tape’s contents are not visible in the preview 
window.

If the camcorder or tape deck is paused or playing, hold-
ing down the rewind or fast forward button rewinds or 
fast forwards the tape at about 10x speed. The tape’s 
contents are visible in the preview window. Letting go of 
the button  returns the camcorder or tape deck to its pre-
vious mode.

Holding the sssshhhhiiiifffftttt    kkkkeeeeyyyy and pressing the lllleeeefffftttt    aaaarrrrrrrroooowwww key 
rewinds the tape; sssshhhhiiiifffftttt----rrrriiiigggghhhhtttt    aaaarrrrrrrroooowwww fast forwards it.

• Step The step keys allow you to advance or rewind the 
tape one frame at a time. Each time you press one of the 
step buttons, the tape moves forward or backward one 
frame.

From the keyboard, use the lllleeeefffftttt    aaaarrrrrrrroooowwww    key to step one 
frame backward and the rrrriiiigggghhhhtttt    aaaarrrrrrrroooowwww key to step one 
frame forward.

• Search The search buttons allow you to easily locate 
the beginning of the previous or next clip on the tape. 
When one of the search buttons is pressed, MotoDV ana-
lyzes the DV data stream to determine where clips begin 
and end. It advances or rewinds at about 10x speed, stop-
ping approximately at the beginning of the appropriate 
video clip.

From the keyboard, hold down the sssshhhhiiiifffftttt    and    ccccoooonnnnttttrrrroooollll        keys 
(Windows) or    ooooppppttttiiiioooonnnn    key (Mac) and press the lllleeeefffftttt    aaaarrrrrrrroooowwww 
key to search backward to the previous clip. To search 
forward to the next video clip, hold the sssshhhhiiiifffftttt    and    ccccoooonnnnttttrrrroooollll        
keys (Windows) or ooooppppttttiiiioooonnnn    key (Mac) and press the    rrrriiiigggghhhhtttt    
aaaarrrrrrrroooowwww key.

• Slow Play The slow play buttons allow you to play the 
tape at one-10th speed, either forward or backward. 
From the keyboard, hold down the ccccoooonnnnttttrrrroooollll key and press 
the rrrriiiigggghhhhtttt    aaaarrrrrrrroooowwww to slow play forward. To slow play back-
ward, hold down the ccccoooonnnnttttrrrroooollll key and press the lllleeeefffftttt    aaaarrrrrrrroooowwww 
key.

Keyboard equivalents summary
The following summarizes the keyboard equivalents :

Pause/play: Space bar or up arrow
Stop: Down arrow
Rewind: Shift-left arrow
Fast forward: Shift-right arrow
Step back: Left arrow
Step forward: Right arrow
Search back: Shift-control-left arrow (Win) or 

Option-left arrow (Mac)
Search forward: Shift-control-right arrow (Win) or 

Option-right arrow (Mac)
Slow play back: Control-left arrow
Slow play forward: Control-right arrow
Capture: Enter or return
Cancel/Done: Escape (Win) or Command-period (Mac)

Timecode menu
MotoDV’s timecode menu displays the timecode of the 
video as well as the time and date that it was recorded. 
Hold down the small pop-up menu to change which infor-
mation is displayed.

Timecode in hours:minutes:seconds;frames (Windows)
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Timecode in hours:minutes:seconds;frames (Mac OS)

If you think you will need to recapture the exact same 
clips at some point in the future, note the timecode of the 
in and out points of each clip. The timecode is displayed 
as hours:minutes:seconds;frames.

NNNNooootttteeee::::    Some DV camcorders and tape decks reset the time-
code to 00:00:00;00 if you leave blank, unrecorded space 
between video clips. In this case, you will have more than 
one frame with the same timecode on your tape. If neces-
sary, also note the time and/or date of the video clip.

Capturing from the lens
You capture clips directly from a camcorder’s lens much 
the same way you capture when in VTR mode. However, 
because you are not acquiring video recorded on tape, 
MotoDV’s keypad will be inactive.

Inactive keypad

To capture images from the camcorder’s lens:

1  Set the camcorder to camera mode and point it at the 
subject matter you wish to capture. Be sure to remove 
your lens cover.

NNNNooootttteeee::::    Some camcorders go to “sleep” when in camera 
mode for an extended period of time. This protects the 
tape heads from excess wear. To keep the camcorder 
“awake” in camera mode, try removing the tape.

2  Set the capture option you prefer, either real time or 
time lapse.

3  Click the Capture button or use the enter or return key 
when you want to start capturing.

4  Click the Stop capture button or use the enter or 
return key to stop capturing. If you are using time lapse 
mode without the manual stop option, MotoDV will auto-
matically stop capturing at the appropriate time.

5  Name and save the clips as described above.

Compensating for slower disks 
You use the MotoDV capture application to acquire DV 
clips from your DV camcorder or tape deck. Before you 
launch the MotoDV application, you may wish to allocate 
additional memory to it to improve capture performance 
on slower disk drives. The procedure to do this is differ-
ent on Windows than on Mac OS.

Windows
To change the amount of memory allocated to the MotoDV 
application for capture, launch the MotoDV Configuration 
Utility located in the MotoDV folder.

Increase the number of buffers in the Buffer Allocation 
section. The Configuration Utility will calculate how 
much RAM you have allocated to MotoDV and warn you if 
you exceed the total amount in your system. In most 
cases, it will allocate about 1MB of RAM for each buffer. 
For example, setting the number of buffers to 32 will usu-

ally allocate 32MB for capture.
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NNNNooootttteeee::::    While the MotoDV Configuration Utility can deter-
mine the total memory in your system, it is not able to 
calculate the amount of memory in use by Windows and 
other applications. Be careful not to assign too much 
memory to MotoDV with the Configuration Utility.

The “Reset All” button in the MotoDV Configuration Util-
ity lets you reset the amount of memory allocated to 
MotoDV to the factory defaults. It also restores the set-
tings and preferences for the MotoDV capture applica-
tion, the SoftDV codec, and the MotoDV Player to their 
initial states.

Mac OS
To change the amount of memory allocated to the MotoDV 
application for capture on Mac OS systems, first quit 
MotoDV if it is running. Then, highlight the MotoDV appli-
cation icon, select Get Info from the File menu, and type in 
the allocation (in KB) in the “Preferred Size” section of 
the Get Info window. (If you are running Mac OS 8.5 or 
later, you will need to select Memory from the pop-up 
menu.) Close the Get Info window.

Assigning memory to MotoDV (Mac OS)

Dynamic buffering
You should have a fast AV disk drive or a disk array con-
nected to your system and normally won’t need to change 
the amount of memory allocated to MotoDV. However, 
MotoDV can utilize additional memory assigned to its par-
tition to buffer the data that it captures, writing that data 
to disk as your computer is able to spare the processing 
cycles.

This “dynamic buffering” feature allows MotoDV to suc-
cessfully capture DV clips for longer durations without 
dropping frames in configurations with marginal disk 
performance. These situations include:

• Disk drives not quite capable of sustaining the DV data 
rate (approximately 3.6MB per second).

• Disk drives that cannot sustain the DV data rate as they 
are filled with media files. 

Note that disk drives write data faster to their outside 
sectors where files are initially stored. As a drive fills up 
with data, its performance typically decreases because 
the data is being written to its slower inside sectors.

• Disk drives that are becoming fragmented.

Dynamic buffering functions much like a garden hose fill-
ing up a bucket with a hole in it. The water going into the 
bucket from the hose represents the DV data stream 
coming in via 1394. The hole in the bucket represents the 
speed of the disk drive. The bucket itself represents the 
memory allocated to MotoDV.

If the water draining out of the bucket is slower than the 
water coming in from the hose, the bucket will eventually 
overflow. The time this takes represents the duration of a 
clip before a frame is dropped (the overflow). You can 
see that if you increase the size of the bucket (MotoDV’s 
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memory allocation) you may be able to capture for longer 
periods of time without incident.

While dynamic buffering can’t compensate for genuinely 
poor disk performance, it can make an important differ-
ence by enabling marginal configurations to successfully 
capture DV clips for longer periods of time.

Playing DV clips with MoviePlayer
Apple’s MoviePlayer is a handy little application that 
comes with QuickTime. It is located in the QuickTime 
folder on your hard disk. If you can’t find MoviePlayer, 
make sure you have run the QuickTime 3 installer 
included on the MotoDV CD-ROM. In addition, the Quick-
Time 2.5 installer should be located on most Mac OS 8 
CD-ROMs.

MoviePlayer is the default application for playing back 
the clips you capture with MotoDV. This means that if you 
double-click on one of these clips, it will launch this appli-
cation and display the first frame of the clip in a standard 
MoviePlayer document, like the one shown here.

A DV clip in a MoviePlayer document

This is useful because you can get a quick look at the 
footage you’ve transfered to your hard disk without 
launching your editing application.

NNNNooootttteeee::::    If your camcorder or tape deck is attached, you can 
also use the  MotoDV Player to view them at full size, in 
full motion by playing them via 1394. See chapter 4 for 
more information on the MotoDV Player.

Typically, the clip will play back smoother if you make 
the window smaller. To make it smaller, use your mouse 
to resize the window from the lower righthand corner. To 
constraint the aspect ratio and maintain the proper 
dimensions of the clip, hold down the alt key (Windows) 
or the option key (Mac OS) when you resize. Note that in 
this case the window snaps to a new size as you move the 
mouse.

Alternately, if you have licensed the Pro Edition of Quick-
Time 3 from Apple or are using MoviePlayer 2.5 with 
QuickTime 2.5 (Mac OS only), you can resize the window 
from the menu bar by selecting one of the options from 
MoviePlayer’s Movie menu. Select Half Size (quarter 
screen, technically speaking) to change the window’s 
resolution to 360 x 240 (NTSC) or 360 x 288 (PAL). Select 
Normal Size from the Movie menu to return to full resolu-
tion.

You can save the new window size for the clip by select-
ing Save from MoviePlayer’s File menu.

NNNNooootttteeee::::    Be aware that ssssaaaavvvviiiinnnngggg clips in MoviePlayer with a 
window size other than full resolution (720 x 480 for 
NTSC DV; 720 x 576 for PAL DV) may cause undesirable 
effects in other QuickTime applications and is not recom-
mended.
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Tips for smoother playback with SoftDV
To play your DV clips as smoothly as possible in 
MoviePlayer (and other QuickTime applications) with the 
Radius SoftDV codec,

1  Assign more memory to MoviePlayer (Mac OS only). 
Select Get Info from the File menu and allocate at least 
6MB (6000KB) of RAM to it.

2  Make the MoviePlayer window smaller by resizing it 
from the lower righthand corner or from the Movie 
menu.

3  Make sure the clips you want to play are on a suffi-
ciently fast hard disk.

4  Set the Radius SoftDV codec’s playback options to bet-
ter match the capabilities of your computer. The proce-
dure to do this differs slightly between the Windows and 
Mac OS versions of MotoDV.

On Windows systems, launch the Digital Origin DV 
Options application located in the MotoDV folder by dou-
ble-clicking on it. The Radius SoftDV Options window will 
appear. The various playback options are useful when 
editing your DV clips. 

Radius SoftDV options (Windows)

• Select a playback image quality that is less than full 
resolution, either draft or intermediate mode. Draft mode 
decodes less of the image and therefore appears some-
what “soft”. However, it plays back the fastest.

NNNNooootttteeee::::    Before rendering your DV clips to a format or com-
pression scheme other than DV, such as Cinepak, 
SoftDV’s Playback Image Quality may need to be set back 
to “Full”.

• Select the number of frames you want to play back. For 
NTSC video, choosing every frame plays 30 frames per 
second, every second frame, 15 frames per second, every 
third frame, 10 frames per second, etc. For PAL video, 
choosing every frame plays 25 frames per second, every 
second frame 12 to 13 frames per second, etc.

On Mac OS systems, these SoftDV options are set using  
the SoftDV control strip at the bottom of your screen.

The SoftDV control strip (Mac OS)

With a little experimentation, you can find the right play-
back quality and speed for you and your system. As the 
speed of desktop computers increases, you will be able to 
play your DV clips on your computer screen at larger 
sizes with more resolution. 

Again, if your camcorder or tape deck is attached to your 
system, you can use the MotoDV Player to play your DV 
clips via 1394 at full size, in full motion, as described in 
chapter 4 of this user guide.

You are now ready to begin editing your DV clips with 

Adobe Premiere LE, as described in chapter 3.
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Chapter 3: Editing DV with Premiere LE

his chapter explains how to begin editing your 
DV footage with Adobe Premiere LE. For com-
plete instructions on using Premiere LE, refer to 

Adobe’s electronic documentation included on the MotoDV 
CD-ROM. 

Loading a project preset
If you installed Premiere LE before the MotoDV software, 
then the MotoDV installer placed the MotoDV presets in 
the Premiere LE Settings folder (Windows only). If you 
have a Mac OS system, move the MotoDV presets from 
the MotoDV folder to the Premiere LE Settings folder 
before you launch Premiere LE. The MotoDV presets 
ensure that all the necessary  parameters are properly 
set for editing DV footage.

To load a MotoDV project preset,

1  First make sure your DV camcorder or tape deck is on. 
If you are using a camcorder, set it to VTR mode.

2  Launch Premiere LE. You should see:

3  Select one of the MotoDV presets depending on the 
video format of your equipment (NTSC or PAL), the 
aspect ratio of your footage (either 4:3 or 16:9 wide-
screen), and the audio sampling frequency you plan to 
use (usually 32, 44.1, or 48kHz). Then click OK.

Load Project Settings in Premiere LE (Mac OS)

Choosing an audio sample rate
When choosing the audio sampling rate for your project, 
note that:

• If you are using a “professional” DV camcorder or tape 
deck, such as one of Sony’s DVCAM products, you should 
select either 32kHz or 48kHz. Both of these audio fre-
quencies can be “locked”, a requirement for the audio in 
DV streams output to this type of equipment.

• If you are using a “consumer” DV camcorder or tape 
deck, such as the Canon XL1, you can select any of the 
three sampling frequencies.

• 32kHz  is the sampling frequency at which many of the 
“consumer” DV camcorders record audio through their 

T

Load Project Settings in Premiere LE (Windows) built-in microphones. If all of the audio in your project 
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comes from the camcorder’s microphone, this is a good 
option to use.

NNNNooootttteeee:::: DV camcorders and tape decks typically record 
32kHz audio  at 12-bits per sample (companded). MotoDV 
converts 32kHz audio to 16-bits per sample (linear) as 
clips are being captured so that these clips can be 
imported into Premiere LE and other QuickTime applica-
tions. 

MotoDV converts 32kHz audio back to 12-bits per sample 
(companded) when a clip or movie with this audio sam-
pling rate is output via 1394.

• 44.1kHz is the sampling frequency recorded on music 
CDs. Again, this frequency should only be used with    
consumer-type DV equipment that does not require locked 
audio.

• 48kHz is the sampling frequency recorded on Digital 
Audio Tape (DAT). If your DV tape was recorded in “16-bit 
mode”, use this sampling frequency.

NNNNooootttteeee:::: The audio sample rates that can be recorded from 
your computer to a DV tape are generally not dependent 
on the recording capabilities of the DV device itself. For 
example, you can record any of the “unlocked” audio 
sample rates (32, 44.1, and 48kHz) to a consumer DV 
camcorder even if the camcorder itself can only record 
32kHz audio from its built-in microphone. You can record 
either of the locked audio sample rates (either 32kHz or 
48kHz) to most professional DV devices. Check the docu-
mentation included with your DV device for any limita-
tions when recording digitally via 1394.

Setting scratch disks
Before you can begin editing DV clips in Premiere LE, you 
should select the disk that it will use as a scratch disk 
when rendering its previews.

To select a scratch disk for Premiere LE,

1  From the File menu, select Preferences > Scratch 
Disks/Device Control....

2  Choose a scratch disk for the clips you will capture as 
well as one for your video and audio previews. 

Setting the scratch disk for Premiere LE (Windows)

Setting the scratch disk for Premiere LE (Mac OS)
3  Click OK.
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Importing DV clips
To edit your DV clips with Premiere LE, you need to first 
import them into your Premiere LE Project window.

To import DV clips into Premiere LE,

1  Make sure the Premiere LE Project window is the 
active window by clicking on it.

2  From the Premiere LE Project window select Import > 
File. Alternately, you can simply double-click on the  
Project window.

3  Navigate to the folder or directory that contains your 
captured DV clips and select one to import. Click the Open 
button (Windows) or the Import button (Mac OS).

4  Repeat this process to import other DV clips. Hold the 
shift key down as you select clips (Windows) or use the 
Import > Multiple menu selection (Mac OS) to import 
more than one clip at a time. 

Playing clips via 1394 (Windows)
The MotoDV Playback plug-in creates an editing mode in 
Premiere LE that continually and transparently trans-
ports video and audio via 1394 to an attached DV device. 
Hence, you can play and scrub your clips at full resolu-
tion and in full motion on a video monitor attached to 
your camcorder or tape deck when you are working in 
Premiere LE. 

If you installed Premiere LE before the MotoDV software 
as instructed in chapter 1, then the MotoDV Playback 
plug-in was placed in the Premiere LE plug-ins folder by 
the MotoDV installer.

NNNNooootttteeee::::    The MotoDV Playback plug-in replaces the original 
MotoDV “Print2DV” export plug-in, adding additional 
functionality and more transparent operation. If you 
have upgraded from a previous version of MotoDV, 
remove the Print2DV plug-in from your Premiere plug-
ins folder if it is still present.

The MotoDV Playback plug-in also allows you to play 
your video projects directly from the Premiere LE time-
line, bypassing the file size limit that prevents any single 
clip from being larger than 2GB. It also saves you sub-
stantial amounts of disk space because the “straight 
cuts” in your video do not need to be rendered; just your 
effects, titles, and transitions.

To play a clip via 1394 in Premiere LE,

1  If you have not already done so, import one or more of 
the DV clips you captured into the Premiere LE Project 
window, as described above.

2  Drag a clip from the Project window into the Source 
preview on the left side of the Monitor window.

3  Click the Play button under the Source preview. The 
clip’s video should be visible on a video monitor attached 
to your DV device. (The image in the Source preview on 
your computer screen will remain static while the clip is 
playing via 1394.) If you don’t have a monitor attached 
and are using a camcorder, look in the viewfinder or at 
its built-in LCD screen, if one is present. 
The MotoDV Playback editing mode in Premiere LE (Windows)
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NNNNooootttteeee:::: When you are ppppllllaaaayyyyiiiinnnngggg clips in the MotoDV Playback 
mode, the audio, as well as the video, in your DV clips is 
exported to the attached DV device via 1394. To hear this 
audio, you will need to connect your speakers to your 
camcorder or tape deck or use head phones, if your 
device does not have its own internal speakers. Refer to 
chapter 1 for instructions on configuring your system.

To scrub a clip via 1394 in Premiere,

1  If you have not already done so, import one or more of 
the DV clips you captured into the Project window. 

2  Drag a clip from the Project window into the Source 
preview on the left side of the Monitor window.

3  Drag the cursor under the Source preview back and 
forth to scrub through the clip. (You can monitor the 
video on either your video monitor or in the Source pre-
view on your computer screen when you are scrubbing.)

NNNNooootttteeee:::: When you are ssssccccrrrruuuubbbbbbbbiiiinnnngggg clips in the MotoDV Play-
back mode, the audio in the clip is played by the com-
puter, NOT the attached DV device. If your speakers have 
two inputs, then you can connect them to both your 
computer and your camcorder or tape deck, as described 
in chapter 1. This will allow you to monitor your audio at 
all times.

Timeline playback
In addition to playing back video and audio via 1394 from 
the Premiere LE clip and Monitor windows, the MotoDV 
Playback plug-in allows you to play directly from the 
Premiere LE timeline.

NNNNooootttteeee:::: Any effects, titles, or transitions in your project 
must first be rendered to the DV format before they can 
be played via 1394 to your DV device. Unrendered effects 

To play or scrub from the Premiere LE timeline,

1  If you have not already done so, import one or more of 
the DV clips you captured into the Premiere LE Project 
window.

2  Drag a clip from the Project window to the Video 1A 
track on the Premiere LE timeline. You can change the 
length of the clip in the timeline by dragging on its end 
point. Note that the preview on the right side of the Pre-
miere LE Monitor window is another representation of 
the video you are building in the timeline.

3  Move the timeline cursor to the start and press the 
space bar to start playing the video. You should be able to 
watch it play on the video monitor attached to your DV 
device. The image in the Monitor window’s righthand 
preview should be static. The audio is played by the cam-
corder or tape deck when you are playing via 1394.

4  Alternately, drag the timeline cursor back and forth in 
the timeline to scrub through your clip. Both the video on 
the monitor and in the preview window should be active. 
The audio is played by the computer when you are scrub-
bing via 1394.

5  Drag a second clip to track Video 1B in the Premiere LE 
timeline, leaving some overlap with the first clip in track 
Video 1A. 

6  Drag a transition from the Transition window to the 
Transition track between the two clips. Stretch the blue 
work area bar at the top of the timeline to match the 
length of the two clips.

7  Save your project and then type Enter. Premiere LE 
will render the transition and then play the two clips with 
the transition via 1394.  

Note that only the transition and audio needed to be ren-
dered for playback via 1394. The unchanged video por-
must be previewed on the computer screen. tions of your clips were played in real time. 
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In addition, this timeline playback capability allows you 
to bypass the 2GB file size limit. While no single clip can 
be larger than 2GB, MotoDV Playback allows you to 
sequence a series of clips in the Premiere LE timeline up 
to 3 hours in length and play them back via 1394.

Recording to tape (Windows)
After you have completed your video project, the MotoDV 
Playback plug-in allows you to record it to tape via 1394.

To record to tape,

1  Assemble your video project in the Premiere LE time-
line and render any effects, titles, and transitions that 
you add to it. 

2  Insert a few seconds of black at the beginning of your 
project. You may also wish to include color bars and a 
1kHz tone.

3  Insert a blank tape into your camcorder or tape deck, 
making sure that it is not write protected. (Be careful not 
to record over one of your source tapes!) If you are using 
a camcorder, make sure it is in VTR mode.

4  Position Premiere LE’s timeline cursor at the begin-
ning of your project and type the space bar to start play-
ing your video.

5  Press the record button on your camcorder or tape 
deck. When your video has ended, press the stop button 
on the DV device. 

NNNNooootttteeee::::    You cannot record a video project with 44.1kHz 
audio to a professional DV (e.g. DVCAM) device. You must 
use either 32 or 48kHz, one of the “locked” audio sample 
rates. To change your project’s audio sample rate, 
choose Project > Settings > Audio... and select either 32 
or 48kHz. Then stretch the Premiere LE work area bar 

Playing and recording via 1394 
(Mac OS)
On Mac OS, the Print to MotoDV plug-in allows you to 
play DV clips and movies to an attached DV device via 
1394 from either the Premiere LE Monitor window or 
from the Premiere LE timeline. Be sure you have copied 
the Print to MotoDV plug-in from the MotoDV folder to 
the Premiere LE plug-ins folder before launching Pre-
miere LE.

To print to MotoDV from Premiere LE’s Monitor 

window,

1  If you have not already done so, import one or more of 
the DV clips you captured into the Premiere LE Project 
window, as described above.

2  Drag a clip from the Project window into the Source 
preview on the left side of the Monitor window.

3  From the Premiere LE File menu, select Export > Print 
to MotoDV.... 

The MotoDV Player options window should appear on 
screen as shown here.

MotoDV Player options (Mac OS)

4  After you have made the appropriate settings for your 
DV device, (described in chapter 4), click the Play button. 
To record, hold the shift key down and click the Record 
for the duration of your project and type enter. button.
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To print to MotoDV directly from the Premiere LE 

timeline,

1  If you have not already done so, import one or more of 
the DV clips you captured into the Premiere LE Project 
window.

2  Drag a clip from the Project window to the Video 1A 
track on the Premiere LE timeline. You can change the 
length of the clip in the timeline by dragging on its end 
point. Note that the preview on the right side of the Pre-
miere LE Monitor window is another representation of 
the video you are building in the timeline.

3  Drag a second clip to track Video 1B in the Premiere LE 
timeline, leaving some overlap with the first clip in track 
Video 1A 

4  Drag a transition from the Transition window to the 
Transition track between the two clips. Stretch the blue 
work area bar at the top of the timeline to match the 
length of the two clips.

5  Save your project and then type Enter. Premiere LE 
will render the transition.

6  From the Premiere LE File menu, select Export > Print 
to MotoDV.... The MotoDV Player options window should 
appear, as described above. 

7  After you have made the appropriate settings for your 
DV device, (described in chapter 4), click the Play button. 
To record, hold the shift key down and click the Record 
button.

NNNNooootttteeee:::: Make sure the tape you are recording to is not 
write-protected.

Note that only the transition and audio needed to be 
rendered for playback via 1394. The unchanged video 
portions of your clips were played in real time.

In addition, the Print to MotoDV plug-in allows you to 
bypass the 2GB file size limit. While no single clip can be 
larger than 2GB, the Print to MotoDV plug-in allows you 
to sequence a series of clips in the Premiere LE timeline 
up to 3 hours in length and play them back via 1394.
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Chapter 4: “Printing” to DV

his chapter explains how to use the standalone 
MotoDV Player application to playback and 
record your DV footage via 1394 to DV camcord-

ers and tape decks. This chapter also explains how to 
control the playback of your clips, with the mouse or 
from the keyboard, as they are being played from your 
disk drive.

Using the MotoDV Player
The MotoDV Player is a standalone application that 
allows you to play and record DV clips and movies via 
1394 without using an editing application.

NNNNooootttteeee:::: (Windows only) The MotoDV Player application 
cannot be running at the same time as the MotoDV cap-
ture application or Adobe Premiere LE with the MotoDV 
Playback plug-in installed in its plug-ins folder.

To play a movie via 1394 with the MotoDV Player,

1  Make sure your DV device is on and connected to the 
1394 FireWire card. If you are using a camcorder, it must 
be set to VTR mode.

NNNNooootttteeee::::    Your DV device must support DV input via 1394 in 
order to play and record DV clips and movies transfered 
to it from your computer.

2  Double click on the MotoDV Player icon, located in 
your  MotoDV folder. The MotoDV Player window 
appears.

The MotoDV Player window (Windows)

The MotoDV Player window (Mac OS)

3  Locate the DV clip or movie you want to play or 
record. On Windows, Select File > Open (Control-O) or 
use the Browse button to the right of the Path field. On 
Mac OS, navigate to the file you want to play and click 
Open. 

NNNNooootttteeee:::: You can also drag and drop a clip onto the MotoDV 
Player application. 

T
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4  On Windows, select File > Preferences (Control-P) to 
open the MotoDV Player preferences window.

MotoDV Player preferences (Windows)

On Mac OS, this window opens automatically when you 
open a file.

MotoDV Player preferences (Mac OS)

• Playback You can play the clip once or have it loop by 
clicking the appropriate button. Check the Play Audio box 
to output audio as well as video.

• Deck Type Select the type of camcorder or tape deck 
you are using. “Consumer” refers to those devices, such 
as the Sony DCR-VX1000 and Canon XL1, that record 
“unlocked” audio. “Pro” refers to devices, such as Sony 
DVCAM or Panasonic DVCPRO equipment, that record 
“locked audio”.

NNNNooootttteeee:::: You cannot output 44.1kHz audio to “Pro” equip-
ment, like Sony’s DVCAM devices, because this is not a 
locked audio sampling rate. Use either a 32kHz or 48kHz 

sampling rate with Pro equipment. 
If you are having trouble recording to a Pro device, make 
sure you have the “Pro” button selected and are output-
ting either 32kHz or 48kHz audio. Note that some Pro 
equipment only accepts 48kHz audio. See the user guide 
for your particular device for additional information.

If you are controlling your camcorder or tape deck via 
LANC, check the “External LANC” box (Windows) or 
uncheck the “DV Device Control” box (Mac OS) so that 
the MotoDV Player’s device control commands do not con-
flict with those coming in over LANC.

• Blank screen If you want to blank the screen before 
and/or after the footage you are exporting, enter the 
desired number of seconds in the appropriate boxes. If 
you want color bars displayed during the blanking 
period, check the “Blank with Color Bars” box.

5  After you have set the preferences, click the OK button 
to close the preferences window (Windows only) and 
then click the Play button.

To record your DV clip or movie to tape via 1394 

with the MotoDV Player, 

1  Make sure your DV device is on and connected to the  
1394 FireWire card. If you are using a camcorder, it must 
be set to VTR mode.

2  Launch the MotoDV Player application and open the 
clip or movie you want to record, as described above.

3  On Windows, select File > Record To Tape (Control-R) 
and confirm that you want to record by clicking Begin. On 
Mac OS, hold down the shift click to activate the Record 
button. Click Record.

NNNNooootttteeee:::: Make sure the tape you are recording to is not 

write-protected.
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Controlling playback from disk
The MotoDV Player window includes a keypad that 
allows you to control clips and movies being played back 
via 1394 from your disk drive (Windows only). These 
controls are described here along with their correspond-
ing keyboard shortcuts. Keyboard control is available for 
both Windows and Mac OS.

• Play/pause Press the play/pause button or use the 
space bar to start your playback and then pause it.

• Stop To stop playback, press the stop button or hit the 
escape key (Windows) or type command-period (Mac 
OS).

• Fast forward Click the fast forward button to play 
your clip at about 10x speed or press both the shift key 
and the right arrow key. 

• Rewind Click the rewind button to play your clip back-
ward at about 10x speed or press both the shift key and 
the left arrow key.

• Step Use the step keys on the keypad to step one 
frame at a time, either forward or backward. You can 
also use the left and right arrow keys on the keyboard.

• Fast step To step forward quickly, first pause play-
back with the space bar, then hold down the control key  
and the right arrow key. To step backward quickly, pause 
playback with the space bar, then hold down the control 
key and the left arrow key.

• Go To Start/Go To End To jump to the start of your 
clip, first pause playback then click the Go To Start button 
or hold down the alt key (Windows) or option key (Mac 
OS) and press the left arrow key. To jump to the end of the 
clip, click the Go To End button or hold down the alt key 
(Windows) or option key (Mac OS) and press the right 
arrow key.



38 Chapter 4
“Printing” to DV



  39
Appendix A: Troubleshooting

his appendix contains solutions to some of the 
problems you may encounter setting up and 
using MotoDV.  In many cases, the error mes-

sages will provide sufficient detail so that you can cor-
rect any problems. However, should the cause of a 
problem not be immediately evident, this appendix may 
be of some assistance. Before calling Digital OriginTech-
nical Support or your reseller for help, please take a 
minute to review this information. You should also 
review the MotoDV read me file included with the 
MotoDV software for any technical issues discovered 
after this manual was printed.

NNNNooootttteeee::::    Because new DV devices are constantly be intro-
duced, it is important to check the Digital Origin web site 
at www.digitalorigin.com for the most recent list of DV 
camcorders and tape decks tested with MotoDV and for 
the latest software updates. 

If you do need to call Digital Origin Technical Support, 
please have the following information ready. Most of this 
information can be determined from the Windows Device 
Manager (for 95/98), the Setup menus, in various control 
panels, or from your product packaging. You should also 
be prepared to provide as detailed a description of the 
problem as you can, including the wording of any error 
messages you are seeing.

Be aware that video editing is a high-performance appli-
cation that places higher than normal demands on your 
system. Any number of variables could affect the way 
your system functions. Providing complete configuration 
information will, in most cases, be worth the time it takes 

_______________________________________________________
Digital Origin product name and version

_______________________________________________________
DV device manufacturer, model, and serial number

_______________________________________________________
Premiere, Photoshop, QuickTime, and DirectX versions installed

_______________________________________________________
Operating system, version, and service packs installed

_______________________________________________________
Computer manufacturer and model

_______________________________________________________
Processor type and speed

_______________________________________________________
Motherboard manufacturer and chip set type

_______________________________________________________
BIOS manufacturer and version

_______________________________________________________
Total memory (RAM) installed

_______________________________________________________
Sound card/subsystem manufacturer and driver version

_______________________________________________________
Graphics card/subsystem manufacturer and driver version

_______________________________________________________
Display resolution and bit-depth you are working in

_______________________________________________________
Disk manufacturer, model, and type (e.g. UltraDMA vs. SCSI)

_______________________________________________________
Size of partitions and file system type (FAT, FAT32, NTFS, HFS, HFS+)

_______________________________________________________
Disk controller manufacturer and type (e.g. IDE vs. SCSI)

_______________________________________________________
Network/modem card manufacturer, bus type, and driver version

_______________________________________________________
Other cards installed, bus type, and driver versions

T

to collect it.
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Troubleshooting principles
Before you move on to more specific recommendations, a 
couple of general troubleshooting principles may help 
you find a solution faster.

• Change or add to your system one component at a time. 
For example, if you are also installing a network card, in 
addition to MotoDV, install one product first and get it up 
and running before installing the second product. If you 
are installing two new Ultra DMA drives, put one in in 
first and verify that you can capture to and playback 
from it with MotoDV. Then add the second drive. Chang-
ing two things at once makes it much more difficult to 
isolate problems.

• Unless it is obvious, do not be too quick to draw a con-
clusion about the cause of the problem. This is especially 
easy to do if you don’t follow the suggestion above and 
change more than one component in your system at the 
same time. Be observant and keep an open mind. Nar-
rowing your focus too early can cause you to waste a lot 
of time.

Configuration issues

Windows configuration issues
A systematic review of your configuration can be helpful 
before moving on to more specific suggestions.

• Review the MotoDV system requirements listed in the 
introduction to this user guide to ensure you have all the 
necessary hardware and software.

• Make sure the 1394 FireWire host adapter card is prop-
erly installed and that the 1394 digital interface cable is 
connected from the card to the DV device.

• Make sure the driver for the 1394 FireWire host 

adapter card is not conflicting with another device. See 
chapter 1 for information on verifying the driver installa-
tion for Windows 95, 98, and NT4. 

If you have a driver conflict, use the Windows help sys-
tem to try to resolve it. From the Start menu choose Help 
and display the “Troubleshooting hardware conflicts” 
topic, following the step-by-step procedures presented by 
this help wizard.

If that does not resolve the problem, try moving the 1394 
FireWire card to another PCI slot in your computer, if one 
is available. Also, be sure you have the latest software 
driver for your graphics card and any other PCI cards 
you may have installed in your system. 

NNNNooootttteeee:::: MotoDV software is not currently compatible with 
1394 FireWire cards from other manufacturers.

• For Windows NT, make sure the Radius 1394 Bus Man-
ager service has started. From the Start menu choose 
Settings and then Control Panel. Open the Services con-
trol panel and scroll down until you see the Radius 1394 
Bus Manager entry. Verify that it has started. If not, high-
light it and click the Start button in the Services window.

• If you are using Windows 98, make sure that you did 
not accidentally install one of the 1394 drivers included 
with Windows 98. You must use the 1394 driver included 
on the MotoDV CD-ROM. If you installed the wrong driver, 
use the Device Manager to remove it. Then install the 
correct driver from the MotoDV CD-ROM.

• Make sure you have installed all necessary software 
included on the MotoDV CD-ROM, including the QuickTime 
and (for Windows 95) DirectX software. Verify that your 
graphics card or subsystem is compatible with DirectX 
and obtain newer drivers from your graphics vendor, if 
necessary. If you are using Windows NT, make sure you 

have installed Service Pack 4.
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• Verify that the MotoDV presets are located in the Pre-
miere LE Settings folder and that the MotoDV Playback 
plug-in is in the Premiere LE Plug-ins folder.

• Make sure you have at least 64MB of RAM, preferably 
128MB, in your system. Low memory conditions can 
cause some applications to perform in an unpredictable 
manner.

Mac OS configuration issues
• Make sure that all of the MotoDV extensions are in the 
extensions folder of your active system folder. The 
MotoDV installer places its extensions in this folder. If you 
dragged files into your system folder, they may not all be 
in the extensions folder or you may have placed them in a 
system folder that is not the active one.

• Make sure that utility software used to manage system 
extensions is not preventing the MotoDV extensions from 
loading when your computer starts up. Use of an exten-
sion management utility other than Apple’s Extensions 
Manager is NOT recommended.

• Verify that the SoftDV codec loads when your computer 
starts up. If an “x” appears on its icon during startup, 
then the SoftDV codec did not load. 

• Make sure that QuickTime 2.5 or later is installed in 
your system. If not, install it from the system software 
disks or CD-ROM included with your computer and 
restart your system.

• There may be a conflict with other extensions in your 
system. Disable or remove all unused extensions and con-

puter. Check to see if RadDVCodec loads.

• Make sure the 1394 FireWire card is properly installed 
and that the digital interface cable is connected from the 
card to the camcorder or tape deck.

NNNNooootttteeee:::: MotoDV software is not currently compatible with 
1394 FireWire cards from other manufacturers.

Cannot recover 1394 connection
If you lose the 1394 connection between your computer 
and your DV device (e.g. the error message starts with 
“Can’t initialize...”), try turning the DV device off and 
then on again. If that does not restore the connection, you 
may need to do a clean restart.

• Turn off your computer and your DV device. 

• Wait several seconds.

• Turn on your computer.

• When your computer has completed the startup pro-
cess, turn on your DV camcorder or tape deck. 

Troubleshooting with PhotoDV
If you are having difficulty with MotoDV, try using 
PhotoDV to capture still images. You may need to install 
Photoshop LE, as well as the PhotoDV plug-in from the 
PhotoDV CD-ROM.

Troubleshooting with DV Tester 
(Windows only)
If you are having trouble with both MotoDV and PhotoDV, 
the  DV Tester, located on the MotoDV CD-ROM, will help 
Digital Origin Technical Support isolate the problem.
trol panels in your system folder and restart your com- Launch the DV Tester application located in the Utilities 
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folder on the MotoDV CD-ROM. You should see a window 
that looks like this:

The DV Tester

• If the picture of the 1394 card is grayed out or if there 
is no manufacturer or device ID in the 1394 Devices sec-
tion, there may be a problem with the driver installation.

• Click one of the device control buttons in the middle of 
the window to see if you have control of the DV device. If 
not, then the 1394 asynchronous channel is not working.

• Click the Test button to test the 1394 isochronous chan-
nel. You should see frames being received. Click the Stop 
button. If you run this test more than once you will see 
one broken frame (ignore this). Otherwise, you should 
not be experiencing broken frames, data overruns, and 
reused buffers.

Problems in Premiere LE
This section discusses problems you may encounter 
when using the MotoDV with Adobe Premiere LE.

((((WWWWiiiinnnnddddoooowwwwssss    oooonnnnllllyyyy))))    WWWWhhhheeeennnn    ppppllllaaaayyyyiiiinnnngggg    aaaa    cccclllliiiipppp,,,,    tttthhhheeee    iiiimmmmaaaaggggeeee    iiiinnnn    tttthhhheeee    
PPPPrrrreeeemmmmiiiieeeerrrreeee    LLLLEEEE    wwwwiiiinnnnddddoooowwww    rrrreeeemmmmaaaaiiiinnnnssss    ssssttttaaaattttiiiicccc    aaaannnndddd    ddddooooeeeessss    nnnnooootttt    uuuuppppddddaaaatttteeee....

• If you are editing in the MotoDV Playback mode with 
the MotoDV Playback plug-in, then this is normal. The 
clip is played via 1394 to an attached DV device. If you do 
not have an LCD screen on your DV camcorder or if you 
are using a tape deck, then you need to connect a video 
monitor to your device to view the video.

YYYYoooouuuu    ggggeeeetttt    aaaa    ““““CCCCaaaannnn’’’’tttt    iiiinnnniiiittttiiiiaaaalllliiiizzzzeeee............””””    oooorrrr    ““““CCCCaaaannnn’’’’tttt    sssseeeetttt    uuuupppp    DDDDMMMMAAAA............””””    
eeeerrrrrrrroooorrrr    mmmmeeeessssssssaaaaggggeeee    iiiinnnn    PPPPrrrreeeemmmmiiiieeeerrrreeee    LLLLEEEE....

• You may have lost your 1394 connection. Try turning 
the DV device off and then on again. If that does not 
restore the connection, you may need to do a clean 
restart. Turn off your computer and your DV device.  
After waiting several seconds, turn your computer back 
on. When your computer has completed the startup pro-
cess, turn on your DV camcorder or tape deck. Relaunch 
Premiere LE.

YYYYoooouuuu    aaaarrrreeee    uuuunnnnaaaabbbblllleeee    ttttoooo    hhhheeeeaaaarrrr    tttthhhheeee    aaaauuuuddddiiiioooo    iiiinnnn    yyyyoooouuuurrrr    pppprrrroooojjjjeeeecccctttt    wwwwhhhheeeennnn    
ppppllllaaaayyyyiiiinnnngggg    oooorrrr    ssssccccrrrruuuubbbbbbbbiiiinnnngggg    aaaa    cccclllliiiipppp    vvvviiiiaaaa    1111333399994444........

• Remember that when you play via 1394 with MotoDV, 
the DV device actually decodes and plays the audio from 
the DV stream. When you scrub a clip, the computer 
plays the audio. For this reason, speakers with dual ste-
reo inputs are ideal because they can be connected to 
both the computer and the DV device. If your speakers 
only have one input, you can attach them to the computer 
and use headphones to monitor the audio from the DV 
device.
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AAAAfffftttteeeerrrr    ttttrrrraaaannnnssssccccooooddddiiiinnnngggg    ((((eeeexxxxppppoooorrrrttttiiiinnnngggg))))    ttttoooo    aaaannnnooootttthhhheeeerrrr    QQQQuuuuiiiicccckkkkTTTTiiiimmmmeeee    
ccccooooddddeeeecccc    ((((eeee....gggg....    CCCCiiiinnnneeeeppppaaaakkkk)))),,,,    tttthhhheeee    nnnneeeewwww    cccclllliiiipppp    oooorrrr    mmmmoooovvvviiiieeee    aaaappppppppeeeeaaaarrrrssss    
aaaabbbbnnnnoooorrrrmmmmaaaallllllllyyyy    ssssoooofffftttt    aaaannnndddd    ffffuuuuzzzzzzzzyyyy....

• This problem may be related to the SoftDV codec’s Play-
back Image Quality settings which allow you to playback 
DV clips faster on your computer. Before transcoding to 
another QuickTime codec, be sure to set SoftDV’s Play-
back Image Quality to “Full” in the SoftDV options win-
dow, if you have change this setting. See chapter 2 for 
more information on SoftDV’s options.

Capture problems
This section discusses problems you may encounter 
when capturing DV clips with MotoDV.

TTTThhhheeee    MMMMoooottttooooDDDDVVVV    rrrreeeemmmmooootttteeee    ccccoooonnnnttttrrrroooollll    kkkkeeeeyyyyppppaaaadddd    iiiissss    nnnnooootttt    aaaaccccttttiiiivvvveeee    iiiinnnn    tttthhhheeee    
MMMMoooottttooooDDDDVVVV    wwwwiiiinnnnddddoooowwww    aaaannnndddd    nnnnoooo    vvvviiiiddddeeeeoooo    iiiissss    ddddiiiissssppppllllaaaayyyyeeeedddd    iiiinnnn    tttthhhheeee    MMMMoooottttooooDDDDVVVV    
pppprrrreeeevvvviiiieeeewwww    wwwwiiiinnnnddddoooowwww....

• Make sure that you have connected the digital interface 
cable to the 1394 FireWire card and to your camcorder or 
tape deck. Be careful not to unseat the 1394 FireWire 
card from the computer’s PCI slot when you plug in the 
cable.

• Make sure that your camcorder or tape deck is pow-
ered on. If you are using a camcorder under battery 
power, make sure that the battery is not dead.

• If you are using a camcorder in camera mode, the 
MotoDV keypad will be inactive. If you do not see any 
video in the preview window, be sure you have removed 
the lens cap.

• (Mac OS only) Make sure that you have not placed cop-
ies of the MotoDV system extensions in the same folder or 
at the same directory level as the MotoDV application. 

in your active System Folder. If you want to store copies 
of these files, put them in a separate folder from the 
MotoDV application.

• Some camcorders need to be plugged into AC power for 
their 1394 ports to function. Check your camcorder docu-
mentation.

• If the above suggestions do not help, try shutting down 
your computer and waiting a few seconds. Then restart 
your computer and try capturing again with MotoDV.

TTTThhhheeee    MMMMoooottttooooDDDDVVVV    rrrreeeemmmmooootttteeee    ccccoooonnnnttttrrrroooollll    kkkkeeeeyyyyppppaaaadddd    iiiissss    aaaaccccttttiiiivvvveeee    bbbbuuuutttt    nnnnoooo    vvvviiiiddddeeeeoooo    
iiiissss    ddddiiiissssppppllllaaaayyyyeeeedddd    iiiinnnn    tttthhhheeee    MMMMoooottttooooDDDDVVVV    pppprrrreeeevvvviiiieeeewwww    wwwwiiiinnnnddddoooowwww....

• Make sure you have inserted a DV tape in the cam-
corder or tape deck.

• If the keypad’s stop button is red, press the pause/play 
button (or the space bar) to start the tape playing. If you 
still do not see anything, rewind or fast forward to 
ensure you are not at a blank spot or at the end of the 
tape. Check the viewfinder or an attached video monitor 
to see if there is any video being displayed. Also, blank 
sections of tape will not generate any timecode informa-
tion.

• Make sure you have selected the appropriate video for-
mat (NTSC or PAL) in the MotoDV Preferences window.

TTTThhhheeee    pppprrrreeeevvvviiiieeeewwww    wwwwiiiinnnnddddoooowwww    ddddooooeeeessss    nnnnooootttt    ddddiiiissssppppllllaaaayyyy    ccccoooonnnnttttiiiinnnnuuuuoooouuuussss    vvvviiiiddddeeeeoooo    
dddduuuurrrriiiinnnngggg    aaaa    ccccaaaappppttttuuuurrrreeee....

• (Windows only) The MotoDV preview may not play as 
smoothly while you are capturing DV footage to disk. 
This is normal and is not indicative of any problems, 
unless otherwise noted by MotoDV error messages.
The MotoDV extensions should be in the Extensions folder 



44 Appendix A
Troubleshooting
• Check the Capture Options (MotoDV Windows menu) to 
see if you have inadvertently set MotoDV to capture in 
time lapse mode.

• Make sure you are not capturing with the camcorder or 
tape deck in slow play mode.

TTTThhhheeee    pppprrrreeeevvvviiiieeeewwww    wwwwiiiinnnnddddoooowwww    ddddooooeeeessss    nnnnooootttt    uuuuppppddddaaaatttteeee    dddduuuurrrriiiinnnngggg    aaaa    ccccaaaappppttttuuuurrrreeee....

• Make sure you are not capturing with the camcorder or 
tape deck in pause mode.

MMMMoooottttooooDDDDVVVV    ddddrrrrooooppppssss    ffffrrrraaaammmmeeeessss    dddduuuurrrriiiinnnngggg    ccccaaaappppttttuuuurrrreeee....

• (Mac OS only) Make sure that you have set the Disk 
Cache to its lowest possible setting. In addition, try dis-
abling Virtual Memory if it is on. Use the Memory control 
panel to make these adjustments and restart your sys-
tem.

• Your disk subsystem may not be fast enough to sustain 
the required rate for capturing DV data streams. Check 
the following recommendations:

For Windows machines, capture to an Ultra DMA IDE 
internal drive (or better) or connect a 7200 rpm SCSI 
drive (or better) to an Ultra or Wide SCSI controller. See 
chapter 1 for information on enabling DMA to Ultra DMA 
IDE disk drives.

For Power Macintosh G3 machines, use either the inter-
nal Apple ATA drive or connect a 7200 rpm SCSI drive (or 
better) to an Ultra or Wide SCSI controller.

For Apple and third-party 604-based Mac OS computers, 
connect a 7200 rpm SCSI drive (or better) to the fast 
motherboard SCSI port included on most models or con-
nect the drive to an Ultra or Wide SCSI controller. See 
chapter 1 and below for possible limitations during play-

NNNNooootttteeee:::: The standard external SCSI port on Mac OS comput-
ers is not fast enough to reliably capture and play back 
DV footage, regardless of the speed of your disk drive.

• Make sure you are using MotoDV on a computer with a 
recommended processor. Pentium computers slower than 
200MHz and PowerPC 601 and 603-based machines may 
not be fast enough.

• If possible, try assigning more memory to the MotoDV 
application. MotoDV’s dynamic buffering compensates, to 
some degree, for configurations with less than adequate 
disk performance. See chapter 2 for more informaton.

• (Mac OS only) If you have enabled MotoDV’s “Enable 
audio play-through” option, disable it by unchecking the 
box in MotoDV’s Preferences window.

• If your disk has become fragmented, you may need to 
run a disk optimizer, not included with MotoDV, to defrag-
ment it.

• If necessary, disable other functions, such as your net-
work connection, that may be requiring processor cycles 
during capture. You may need to quit other applications 
open in the background.

• Do not try to capture clips while your computer is run-
ning a background task, such as printing or copying files.

• (Mac OS only) If you continue to experience problems 
capturing, use Apple’s Extensions Manager to run with a 
minimal set of extensions. Be careful not to disable essen-
tial extensions such as FireWire Support, the MotoDV 
extensions (all begin with Rad...), and the QuickTime 
extensions.
back when using a SCSI card in 604-based computers. 
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1394 playback problems
This section helps you solve problems playing back DV 
clips and movies via 1394 to your camcorder or tape 
deck.

IIIIffff    yyyyoooouuuu    ccccaaaannnnnnnnooootttt    ppppllllaaaayyyy    bbbbaaaacccckkkk    vvvviiiiaaaa    1111333399994444    aaaatttt    aaaallllllll,,,,

• If you are using a camcorder, make sure it is set to VTR 
mode and that it is powered on. Verify that your model 
does in fact support input via 1394. Many camcorders, 
PAL models in particular, only support 1394 output to 
another device or computer.

• Check all of your cable and power connections, espe-
cially the 1394 cable. Take extra care not to damage the 
4-pin connector on the cable that attaches to the DV 
device.

• Most camcorders display “DV In” in the viewfinder 
when a 1394 FireWire cable is connected. Check the user 
guide for your camcorder. If DV In should be visible, ver-
ify that you can see it in the viewfinder. If you do not, you 
may have a bad DV port on your DV device.

• If you are using a DV tape deck, make sure you have 
selected the DV input setting. For example, Sony’s DVCAM 
format DSR30 tape deck includes analog, as well as digi-
tal input. The deck must be set to “DV In” to accept 
FireWire input from the computer.

• Try turning the DV device off, then on again. If that does 
not help, shut down the computer, wait five seconds, and 
turn off your DV device. Then restart your system.

AAAAfffftttteeeerrrr    ppppllllaaaayyyyiiiinnnngggg    aaaa    cccclllliiiipppp,,,,    tttthhhheeee    MMMMoooottttooooDDDDVVVV    PPPPllllaaaayyyyeeeerrrr    iiiinnnnddddiiiiccccaaaatttteeeessss    ddddrrrrooooppppppppeeeedddd    
ffffrrrraaaammmmeeeessss    dddduuuueeee    ttttoooo    sssslllloooowwww    ddddiiiisssskkkk    ppppeeeerrrrffffoooorrrrmmmmaaaannnncccceeee....

• Your disk subsystem may not be fast enough to sustain 

Check the following recommendations:

For Windows machines, use an UltraDMA 33 capable 
internal drive (or better) or connect a 7200 rpm SCSI 
drive (or better) to an Ultra or Wide SCSI controller. See 
chapter 1 for information on enabling DMA to Ultra DMA 
IDE disk drives.

For Power Macintosh G3 machines, use either the inter-
nal Apple ATA drive or connect a 7200 rpm SCSI drive (or 
better) to an Ultra or Wide SCSI controller.

For Apple and third-party 604-based Mac OS computers, 
connect a 7200 rpm SCSI drive (or better) to the fast 
motherboard SCSI port included on most models or con-
nect the drive to an Ultra or Wide SCSI controller. 

NNNNooootttteeee:::: The standard external SCSI port on Mac OS comput-
ers is not fast enough to reliably capture and play back 
DV footage, regardless of the speed of your disk drive.

• Make sure you are using MotoDV on a computer with a 
recommended processor. Pentium computers slower than 
200MHz and PowerPC 601 and 603-based machines may 
not be fast enough.

• If your disk has become fragmented, you may need to 
run a disk optimizer, not included with MotoDV, to defrag-
ment it.

• If necessary, disable other functions, such as your net-
work connection, that may be requiring processor cycles 
during capture. You may need to quit other applications 
that are currently running on your computer.

• Do not try to play back clips while your computer is 
running a background task, such as printing or copying 
files.
the required rate for playing back DV data streams. 
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• (Mac OS only) If you continue to experience problems 
during playback, use Apple’s Extensions Manager to run 
with a minimal set of extensions. Be careful not to disable 
essential extensions such as FireWire Support, the 
MotoDV extensions (all begin with Rad...), and the Quick-
Time extensions.

((((MMMMaaaacccc    OOOOSSSS    oooonnnnllllyyyy))))    IIIIffff    ppppllllaaaayyyybbbbaaaacccckkkk    iiiissss    sssseeeevvvveeeerrrreeeellllyyyy    ggggaaaarrrrbbbblllleeeedddd    wwwwiiiitttthhhh    rrrraaaannnn----
ddddoooommmm    bbbblllloooocccckkkkssss    oooorrrr    iiiiffff    yyyyoooouuuu    ggggeeeetttt    aaaa    DDDDMMMMAAAA    eeeerrrrrrrroooorrrr,,,,

• Make sure that Virtual Memory is not on and that you 
have set the Disk Cache to its lowest possible setting. Disk 
Cache settings larger than the minimum setting will pre-
vent you from successfully playing back clips over 
FireWire. Use the Memory control panel to make these 
adjustments and restart your system.

• If you are using a SCSI controller card on a 604-based 
machine, then you may need to slow down the rate at 
which it sends and receives data to and from the attached 
drives in order to prevent it from using excessive band-
width on the PCI bus. SCSI cards using excessive PCI 
bandwidth can prevent the 1394 FireWire card from suc-
cessfully playing DV streams via 1394 (resulting in a 
DMA error) or cause the video to break up with a series 
of random gray blocks. 

You limit a SCSI card’s transfer rate with its control soft-
ware (e.g. Adaptec’s PowerDomain utility for the Adaptec 
2940UW card). Depending on the speed of your attached 
drives, you may need to use the control software to dis-
able Ultra SCSI and wide transfers, and possibly to limit 
the transfer rate. Because the DV data rate is modest 
(3.6MB per second) you generally will not notice any side 
effects as a result of changes to these settings. Contact 
your SCSI card manufacturer if you need assistance lim-
iting its transfer rate.

If you have a 6-slot computer and are using a SCSI con-
troller card, try installing this card in one of the first 
three slots and the 1394 FireWire card in one of the sec-
ond three slots (e.g. slot 4, 5, or 6). For UMAX S900 com-
puters, try installing both the SCSI card and the 1394 
FireWire card in the top two slots. For UMAX J700 com-
puters, try installing the two cards in the two middle 
slots.

1394 recording problems
This section helps you solve problems recording DV clips 
and movies to tape via 1394.

TTTThhhheeee    MMMMoooottttooooDDDDVVVV    PPPPllllaaaayyyyeeeerrrr    ccccaaaannnnnnnnooootttt    rrrreeeeccccoooorrrrdddd    ttttoooo    ttttaaaappppeeee....

• Make sure your tape is not write-protected. The 
MotoDV Player cannot detect write protected tapes and 
may display an inappropriate error message when one is 
encountered.

•  If you are recording to a professional device such as a 
Sony DVCAM tape deck or camcorder, make sure you 
have selected “Pro” (locked) audio in the MotoDV Player 
options window. You should also verify that you are out-
putting either 32kHz or 48kHz audio. 44.1kHz audio is not 
a valid locked audio sample rate. 

Note also that some professional DV devices only accept 
48kHz audio. See the user guide for your device for more 
information. 
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hapter 2 of this user guide describes how to 
use Apple’s MoviePlayer application to view 
and play back the DV clips you capture with 

MotoDV. This appendix explains how to use MoviePlayer 
for cuts-only editing and for resampling audio.

NNNNooootttteeee::::    QuickTime 3 users (Windows and Mac OS) will need 
to purchase a license for the Pro Edition of QuickTime 3 
from Apple in order to enable the editing capabilities of 
MoviePlayer that are described in this appendix. For 
more information, open the “Get QuickTime Pro” movie 
that was installed on your desktop during the QuickTime 
3 installation.

Cuts-only editing with MoviePlayer 
Because MoviePlayer has been, until recently, an undocu-
mented application, many of its capabilities are not par-
ticularly well known. This section describes how to use 
MoviePlayer for cuts-only editing of the DV clips you cap-
ture with MotoDV. 

Although obviously not as powerful as full-blown editing 
applications, you may find that knowing how to edit with 
MoviePlayer comes in handy for basic projects that do 
not require capabilities beyond straight cuts. 

To create a cuts-only movie with MoviePlayer,

1  Launch MoviePlayer by double-clicking on one of the 
DV clips you captured with MotoDV. 

For smoother playback, make the clip window smaller 
and set the SoftDV playback options, as described in 
chapter 2. 

DV clip in MoviePlayer (Windows)

2  Use the buttons at the bottom of the MoviePlayer clip 
to (from left to right) adjust the sound, play and pause the 
clip, and step one frame backward or forward. Holding 
the alt key (Windows) or control key (Mac OS) and click-
ing on one of the step buttons on the right changes these 
buttons into a jog/shuttle controller.

DV clip in MoviePlayer (Mac OS)

C
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Standard QuickTime controller at the bottom of a clip

Alternately, you can simply drag the slider in the middle 
to navigate through the clip. The size box on the far right 
side allows you to resize the clip’s window.

3  Position the slider at the starting point of the portion 
of the clip you want to paste into your new movie, hold 
down the shift key and drag the slider to the end of the 
clip as shown here.

Making a selection with the shift key and slider (Windows)

4  Select Copy from MoviePlayer’s Edit menu. To clear 
your selection and make a new one, click anywhere on 
the gray portion of the slider bar.

5  Select New from the File menu. A new movie appears 
with just the QuickTime controller.

New MoviePlayer movie

6  Select Paste from the Edit menu. The selected portion 
of the DV clip is pasted into your new movie. Both the 
video and sound tracks are included.

7  Open another DV clip, select the portion you want to 
copy with the shift key and the slider, and select Copy 
from the Edit menu. 

8  Position the slider in the new movie at the point where 
you want to insert the next cut and select Paste from the 
Edit menu. You now have a movie with two cuts.

9  Save your movie by selecting Save from the File menu.

MoviePlayer options when you save a movie (Windows)
Make a selection with the shift key and slider (Mac OS)
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MoviePlayer options when you save a movie (Mac OS)

Saving normally means that your new movie just con-
tains pointers to the parts of the original source clips you 
copied. This new movie is small in size but will only play 
back if the source clips are present. If you make the 
movie self-contained, an entirely new movie will be cre-
ated and the portions of the original clips that you 
selected will be copied into it. This new movie is substan-
tially larger but contains all of the movie’s data in a sin-
gle file.

10  You can play back and record the new movie via  
1394 by dragging it onto the MotoDV Player icon, select-
ing the options as described in chapter 4, and clicking OK.

More MoviePlayer options
You can add more cuts to your new movie by repeating 
the steps above. Note that using the Paste command 
inserts new material at the point where you position the 
slider. If you hold down the shift key, the Paste command 
turns into the Replace command. Use this command to 
replace, rather than insert, new material.

In addition to adding new cuts to a movie, you can delete 
material by making a selection and choosing Cut or Clear 
from the Edit menu. If you hold down the alt key (Win-
dows) or option key (Mac OS), the Clear command 
changes to the Trim command, which deletes all of the 
material in the clip that is not selected.

The Copy and Paste commands, as well as the others 
described above, act on all of the tracks in a movie. DV 
clips captured with MotoDV currently have two tracks, a 
video track and a sound track. If you only want to use one 
of the tracks in your DV clip, extract it from the clip into a 
new movie using the Extract command from the Edit 
menu. Once the track is in a new, single-track movie, you 
can select the portion of it you want to use.

You can also add a track to a movie, such as a music 
track to a movie with just video cuts, by using the Add 
command. Extract the track you want to add into a single-
track movie with the Extract command and select the 
portion of it that you want to use. Position the target 
movie’s slider where you want to insert the track. Then 
hold the option key down and select Add from the Edit 
menu.

Audio resampling with Movie-
Player
Some of the most popular DV camcorders, such as Sony’s 
DCR-VX1000, record audio at a sampling frequency of 
32kHz. In contrast, audio is typically recorded on CD at 
44.1kHz and on DAT at 48kHz. As a result, you may find 
yourself working in a project with settings that resample 
your 32kHz audio up to 44.1kHz or 48kHz.



50 Appendix B
Editing with MoviePlayer
If you are not satisfied with the quality of the audio 
resampling provided by your editing application, try 
using MoviePlayer to resample your audio instead.

To resample the audio in a DV clip with MoviePlayer,

1  Open your DV clip in MoviePlayer by double-clicking 
on it.

2  Select Export from MoviePlayer’s File menu.

MoviePlayer’s export window (Windows)

MoviePlayer’s export window (Mac OS)

3  Rename the new movie and set the pop-up menu below 
the name to “Sound to AIFF”.

4  Click the Options button and select 44.1kHz from the 
pop-up menu or enter “48” for a 48.000kHz setting, 
whichever you desire. Then click OK.

MoviePlayer’s export options (Windows)

MoviePlayer’s export options (Mac OS)

5  Click the Save button to save the new movie with just a 
single sound track.

6  Open the new single-track movie in MoviePlayer by 
double-clicking on it or by selecting Open from the File 
menu.

7  Select the entire sound track with the Select All com-
mand in the Edit menu.

Selecting the new sound track

8  Choose Copy from the Edit menu.
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9  Click on your original DV clip so that it is the active 
window in MoviePlayer.

10  Position the slider at the very beginning of the clip.

11  Hold down the option key and choose Add from the 
Edit menu. The new, resampled sound track will be added 
to your DV clip. The clip now has two sound tracks.

12  Select Delete Tracks... from the Edit menu and delete 
Sound Track 1, the original sound track in the clip.

13  Save the clip by selecting Save from the File menu.

Describing all of MoviePlayer’s features is beyond the 
scope of this appendix. However, you may find the proce-
dures explained above to be useful as you edit your DV 
footage.
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Appendix C: Regulatory Approvals

FCC Statement
This equipment has been tested and found to comply with 
the limits for a Class B digital device, pursuant to Part 15 
of the FCC Rules.  These limits are designed to provide 
reasonable protection against harmful interference when 
the equipment is operated in a residential installation.  
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in accor-
dance with the instructions, may cause harmful interfer-
ence to radio communications.  If this equipment does 
cause harmful interference to radio or television recep-
tion, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• Connect the equipment into an outlet on a circuit differ-
ent from that to which the receiver is connected

• Consult the dealer or an experienced radio/TV techni-
cian for help.

• In case of TV or radio interference, turn the antenna 
until the interference stops, or consider installing an 
antenna with coaxial cable lead-in between the antenna 
and the TV.

• Increase the separation between the equipment and 
receiver

• Reorient or relocate the receiving antenna

IIIImmmmppppoooorrrrttttaaaannnntttt::::    Modifications or changes to this product that 
are not expressly approved by Digital Origin could void 
the user's authority to operate the equipment.

To ensure compliance to FCC non-interference regula-
tions, peripherals attached to this computer require 
shielded I/O cables.

You may find the following booklet prepared by the Fed-
eral Communications Commission helpful:

How to Identify and Resolve Radio-TV Interference Problems
Stock # 004-000-00345-4
The above booklet is available from:
U.S. Government Printing Office
Washington, DC  20402
(202) 783-3238

DECLARATION OF CONFORMANCE
We,
Digital Origin, Inc. (formerly Radius Inc.)
460 East Middlefield Road
Mountain View, CA  94043
USA

Declare under our sole responsibility that the product, 
FireWire PCI 2330 card, to which this declaration relates, 
is in conformance with the following standard(s) or other 
normative document(s):

EN55022, EN5082-1
following the provisions of 89/336/EEC - EMC Directive.

* *
Date and place of issue Vice President of Engineering

* The signed and dated Declaration of Conformance is on 

file at the above listed address.
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Canadian RFI Statement
This Class B digital apparatus meets all requirements of 
the Canadian Interference-Causing Equipment Regula-
tions.

Cet appareil numérique de Classe B respecte toutes les 
exigences du Réglement sur le matérial brouilleur du 
Canada.

Japanese VCCI Statement
This equipment is in the 2nd Class category (information 
equipment to be used in a residential area or an adjacent 
area thereunto) and conforms to the standards set by the 
Voluntary Control Council For Interference by Informa-
tion-Technology Equipment aimed at preventing radio 
interference in such residential areas.

When used near a radio or TV receiver, it may become 
the cause of radio interference. Read the instructions for 
correct handling.
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Numerics
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procedure to recover  41
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A
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cable
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Camcorder sleep mode, preventing  24
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direct from the lens  24
Capture Options...  18

improving  24
Capture preferences  19

16x9 (Wide Screen)  20
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discontinuous timecode warning  19
dropped frames warning  19
enable audio playthrough  20
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Capturing
clip handles  21
from tape  21
from the lens  24

Compensating for slower disks  24
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to a DV device  6
Controlling playback from disk  37

D
Deck control  22
Deck Type  36
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Disk performance calculation  19
disk space required  3
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enabling on Windows for IDE drives  14
dropped frames  19
DV data rate  3
Capture performance DV input
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required for 1394 playback  35
DV port  2
DV Tester  41
DVCAM  29, 36
Dynamic buffering  25

E
Editing

the DV format  29
Enable audio playthrough  20
Extensions Manager

Apple  16
third party versions not recommended on Mac OS

computers  16

F
File size

maximum for Windows and Mac OS  21
FireWire

a high-speed serial port  5
fragmented disk drive  14

H
handles  21

I
iLink  2, 5
Importing DV clips  31
Inactive keypad  24
Installation  5

DirectX update for Windows 95  11
MotoDV software for Mac OS  12
QuickTime for Windows  11
QuickTime, MotoDV, and DirectX for Windows  10
Radius 1394 FireWire host adapter card  5
Service Pack 4 for Windows NT  11

Installing
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Installing the 1394 driver  7
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verifying installation  10
verifying on Windows 95/98  10
verifying the NT driver  11
Windows 95  8
Windows 98  7
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Keyboard shortcuts for deck control  23

L
loading a MotoDV preset  29
Locked vs. unlocked audio  36

M
Mac OS 8.0  12

determining version of system software  12
Monitors control panel (Mac OS)  15
MotoDV  5

keypad  22
location of serial number  13
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Windows version vs. Mac OS  2

MotoDV Configuration Utility  24
MotoDV Playback plug-in  31
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MotoDV software

installation for Mac OS  12
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MoviePlayer
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Cuts-only editing  47
cuts-only editing  47
more options  49
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N
Naming

a clip  21
automatic  22

NT Services window  11
NTSC  20
NTSC video format  20

O
Optional equipment  3
Optional equipment and software  3

P
PAL video format  20
Path button  18
Performance

limit extensions and control panels  16
PhotoDV  5
playback

from Premiere clip window  31
from Premiere timeline  32

Power Macintosh 604
recommended disks  15

Power Macintosh G3  15
recommended disks  15

Premiere LE
importing DV clips  31
setting scratch disks  30

Premiere LE Settings folder  29
Premiere plug-ins folder  31
Preview quality slider  20
Preview settings, MotoDV  20
Preview window

settings  20
Preview window settings  20
Print to Radius DV

from Premiere’s Timeline  34
Print2DV export plug-in

replaced by MotoDV Playback plug-in  31

Q
QuickTime

determining version installed on Mac OS  12
QuickTime 2.5  12
QuickTime 3

optional for Mac OS  2
Pro Edition  12, 26, 47
recommended for Mac OS version of Adobe Premiere

5  12

R
Radius DV Player

recording  36
Radius SoftDV  1

playback image quality  27
playback options  27

Real time capture  18
recording to tape  33

with Radius DV Player  36
Remote deck control  22

keyboard commands  23
Pause/Play button  22
Rewind and Fast Forward buttons  23
Search buttons  23
Slow Play buttons  23
Step button  23
Stop button  22

Reset All button  25

S
scratch disk, selecting  30
scrubbing a clip  32
SCSI controller card  15

in UMAX Mac OS computers  16
installing in separate PCI bank in Macs with more

than 3 slots  16
limiting transfer rate on 604 Macs  15

SCSI ports
standard Mac external port not fast enough for DV

15
Selecting a capture location  18
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Selecting a capture mode  18
Selecting the capture mode  18
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Setup information  14
Setup instructions  14
Slower disks

compensating for on Mac OS  25
compensating for on Windows  24

Software playback
optimizing  27

Software playback of DV clips  26
Software updates  3
Sound control panel (Mac OS)  16
Speakers, dual input  3
starting your system  11
System requirements  2

optional equipment  3

T
Time lapse capture  18

parameters  18
Timecode menu  23
Timeline playback  32
timeline playback  31
Troubleshooting  39

Capture problems  41
FireWire playback problems  45
Mac OS configuration issues  41
Windows configuration issues  40

troubleshooting  39
problems in Premiere  42

U
Unpacking  5

V
Video format

selecting NTSC or PAL  20
Virtual Memory (Mac OS)  15
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